
SAP BusinessObjects Profitability and Cost Management Data Bridge User
Guide
■ SAP BusinessObjects Profitability and Cost Management 7.5

2010-01-26



© 2009 SAP AG. All rights reserved.SAP, R/3, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP
Business ByDesign, and other SAP products and services mentioned herein as well as their respective

Copyright

logos are trademarks or registered trademarks of SAP AG in Germany and other countries. Business
Objects and the Business Objects logo, BusinessObjects, Crystal Reports, Crystal Decisions, Web
Intelligence, Xcelsius, and other Business Objects products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks of Business Objects S.A. in the
United States and in other countries. Business Objects is an SAP company.All other product and
service names mentioned are the trademarks of their respective companies. Data contained in this
document serves informational purposes only. National product specifications may vary.These materials
are subject to change without notice. These materials are provided by SAP AG and its affiliated
companies ("SAP Group") for informational purposes only, without representation or warranty of any
kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The
only warranties for SAP Group products and services are those that are set forth in the express
warranty statements accompanying such products and services, if any. Nothing herein should be
construed as constituting an additional warranty.

2010-01-26



Contents

History of changes..................................................................................................................7Chapter 1 

Introduction to SAP BusinessObjects Profitability and Cost Management Data Bridge........9Chapter 2 

Data Bridge Functionality.......................................................................................................102.1
Restrictions............................................................................................................................102.1.1

Data Bridge Files and Input Data..........................................................................................11Chapter 3 

Input Data..............................................................................................................................113.1
Naming Conventions..............................................................................................................143.1.1
Control Files..........................................................................................................................153.2
Specification Files..................................................................................................................163.3
Specification File Statements.................................................................................................163.3.1
Table and Field Selection Statements ....................................................................................173.3.2
Source Data Default Statements...........................................................................................213.3.3
Source Data PreProcessing Statements ...............................................................................253.3.4
Record Statements................................................................................................................263.3.5
Output Data Post Processing Statements..............................................................................303.3.6

Organizing an Update...........................................................................................................33Chapter 4 

Structure................................................................................................................................334.1
Building Hierarchies................................................................................................................344.2
Building a Main Hierarchy.......................................................................................................354.2.1
Building an Attribute Hierarchy...............................................................................................364.2.2
Building Attribute Assignments..............................................................................................384.2.3
The ParentChild Table............................................................................................................394.3
Attribute Flags........................................................................................................................394.3.1
Consolidation Types...............................................................................................................404.3.2
Data Aliases...........................................................................................................................414.3.3
Building Bulk Hierarchies........................................................................................................434.4
Restructuring Large Hierarchies.............................................................................................434.4.1
Bulk Tables............................................................................................................................444.4.2
Assignments..........................................................................................................................444.5

2010-01-263



Values....................................................................................................................................454.6
Import Methods.....................................................................................................................464.7
Overwrite and Append...........................................................................................................474.7.1
Replace..................................................................................................................................474.7.2
Replace and Sum...................................................................................................................484.7.3
Sum New and Existing...........................................................................................................494.7.4

Using Data Bridge.................................................................................................................51Chapter 5 

Data Bridge Interface.............................................................................................................515.1
Logging in/out of models in Data Bridge................................................................................525.2
To login..................................................................................................................................525.2.1
To select a model...................................................................................................................525.2.2
To create a model..................................................................................................................535.2.3
To delete a model..................................................................................................................535.2.4
Links to Datasources.............................................................................................................535.3
Creating links to datasources.................................................................................................555.3.1
Data Bridge Specification File Wizard.....................................................................................655.4
Data Bridge Specification Wizard Workflows.........................................................................655.4.1
Data Bridge Specification Wizard Screens.............................................................................715.4.2
Running the Data Bridge Specification File Wizard.................................................................815.4.3
Running the Control File.........................................................................................................975.5

Running Control Files from a Command Line.......................................................................99Chapter 6 

To run from the command line using PCMCONSOLE............................................................996.1

SAP BusinessObjects Profitability and Cost Management Tables.....................................101Chapter 7 

ACTIVITYDRIVERVALUE.....................................................................................................1017.1
ACTIVITYREASSIGN...........................................................................................................1027.2
ALIAS, ALIAS_BULK...........................................................................................................1027.3
BOUNDARYINFO................................................................................................................1037.4
COSTOBJECTDRIVER........................................................................................................1037.5
CELLMEMOS......................................................................................................................1057.6
COSTOBJECTASSIGNMENT..............................................................................................1077.7
CURRENCYINFO................................................................................................................1077.8
CURRENCYRATE................................................................................................................1087.9
DAVERSION........................................................................................................................1087.10
DEFAULTBOOK..................................................................................................................1097.11
EMPLOYEEBOUNDARY......................................................................................................1097.12
EMPLOYEEBOUNDARYVALUE..........................................................................................1097.13
EMPLOYEERESOURCEDRIVERSPLIT.................................................................................1107.14

2010-01-264

Contents



LINEITEMDETAILVALUE......................................................................................................1107.15
INITIATIVEINFO...................................................................................................................1117.16
EXTACTCOUNITRATE.........................................................................................................1117.17
EXTERNALACTIVITYVALUE................................................................................................1127.18
EXTERNALCOSTOBJECTVALUE........................................................................................1137.19
ICONINFO...........................................................................................................................1137.20
LINEITEMDIRECTACTIVITY.................................................................................................1147.21
LINEITEMFVALUE................................................................................................................1147.22
LINEITEMRESOURCEDRIVER.............................................................................................1147.23
LINEITEMVALUE..................................................................................................................1157.24
LINEITEMVARIABLE............................................................................................................1157.25
MEMOS...............................................................................................................................1167.26
METRICACTUALADJUSTMENTVALUE..............................................................................1167.27
METRICACTUALVALUE......................................................................................................1177.28
METRICBASEPOINTVALUE................................................................................................1177.29
METRICBOUNDARY...........................................................................................................1177.30
METRICBOUNDARYVALUE................................................................................................1187.31
METRICRESPCENTER.........................................................................................................1187.32
METRICTARGETADJUSTMENTVALUE...............................................................................1197.33
METRICTARGETVALUE......................................................................................................1197.34
METRICWEIGHTINGVALUE................................................................................................1197.35
MODELGROUPS................................................................................................................1207.36
MODELSECURITYDESCRIPTORS......................................................................................1207.37
OBJECTIVEACTUALVALUE................................................................................................1217.38
OBJECTIVEACTUALADJUSTVALUE..................................................................................1217.39
OBJECTIVEBASEPOINTVALUE..........................................................................................1217.40
OBJECTIVEBOUNDARY.....................................................................................................1227.41
OBJECTIVEBOUNDARYVALUE..........................................................................................1227.42
OBJECTIVEEMPLOYEE.......................................................................................................1237.43
OBJECTIVEINITIATIVE.........................................................................................................1237.44
OBJECTIVELOBJECTIVE....................................................................................................1237.45
OBJECTIVEMETRIC............................................................................................................1247.46
OBJECTIVERESPCENTER...................................................................................................1247.47
OBJECTIVETARGETADJUSTVALUE...................................................................................1247.48
OBJECTIVETARGETVALUE................................................................................................1257.49
OBJECTIVEWEIGHTINGVALUE..........................................................................................1257.50
PARENTCHILD, PARENTCHILD_BULK, PARENTCHILD_BULK_REPLACE........................1257.51
PROPERTY..........................................................................................................................1267.52
PROPERTYITEM..................................................................................................................1267.53
RESOURCEDRIVERVALUE.................................................................................................1277.54
RESOURCEDRIVERSPLIT...................................................................................................1277.55

2010-01-265

Contents



RESPCENTERACTIVITY......................................................................................................1287.56
RESPCENTERSERVICE.......................................................................................................1287.57
REVENUE............................................................................................................................1287.58
SECURITYDESCRIPTORS...................................................................................................1297.59
SECURITYDESCRIPTORGROUPS......................................................................................1297.60
SECURITYGROUPROOTS..................................................................................................1307.61
SERVICEDIRECTACTIVITY..................................................................................................1307.62
SERVICEDRIVERVALUE.....................................................................................................1317.63
SERVICEFACTOR...............................................................................................................1317.64
SERVICERESOURCEDRIVER..............................................................................................1327.65
SPREADVALUE...................................................................................................................1327.66
TCACTIVITYDRIVERVOLUME.............................................................................................1327.67
USERGROUPS....................................................................................................................1337.68
USERSINFO........................................................................................................................1337.69
WORKSHEETVALUE...........................................................................................................1347.70

Dimensions.........................................................................................................................135Chapter 8 

More Information.................................................................................................................137Appendix A 

Index 139

2010-01-266

Contents



History of changes

The current version of this document is version 1.3. The following table provides an overview of the
most important changes to prior and current versions of this document:

Important ChangesVersion

Initial version of the SAP BusinessObjects Profitability and Cost Management
Data Bridge Guide document for SAP BusinessObjects Profitability and Cost
Management 7.5.

Version 1.0

Document is updated with the surfaced functionality to import data from SAP
Netweaver® Business Warehouse and other datasources.

Version 1.1

Document is updated with supported versions of SAP Netweaver® Business
Warehouse; information on the fetch limit of the SAP Remote Fuction Call; and
how to configure a link to a BusinessObjects Enterprise server using the MDX
Connector when the Profitability and Cost Management client is not installed lo-
cally.

Version 1.2

A note is added on a known issue that occurs when using SQL Server Native
Client 10.0 driver when setting up a link to a datasource.

Version 1.3
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Introduction to SAP BusinessObjects Profitability and
Cost Management Data Bridge

Data Bridge is an intelligent bulk data-input tool for populating the data tables in SAP BusinessObjects
Profitability and Cost Management.

Data Bridge provides the means to transfer data into a model from flat files, such a comma separated
values (CSV) files, and external datasources, such as SAP Netweaver® Business Warehouse (SAP
Netweaver BW ).

Note:
Data Bridge supports SAP Netweaver® BW 7.0 SP20 and later versions.

Other external datasources include spreadsheets, relational databases, and other Online Analytical
Processing (OLAP) cubes. This means you can use Data Bridge to:
• Perform the periodic update of values such as Costs and Driver values that are routinely performed

on established models.
• Import cube data from SAP Netweaver BW, such as query cubes created in SAP Business Explorer

(SAP BEx), into a Profitability and Cost Management model.
• Import database tables from one Profitability and Cost Management model to another
• Import tables from other relational databases into a Profitability and Cost Management model.
• Import model data (cube data) such as structures and values from one Profitability and Cost

Management model to another.

To import data from external datasources, including SAP datasources, Data Bridge enables users to
define links to datasources using various information providers (middleware and application programming
interfaces). Using the links, Data Bridge queries the datasources and retrieves the data in a flattened
form that can be handled similarly to a flat file.

The data to be imported has to be laid out in a format that is defined by a Specification File (SPE file).
Each SPE file maps the chosen input data to a specific Profitability and Cost Management table.

A Control File (CTF file) specifies a list of datasources and SPE files that are to be imported against the
chosen model.

If your datasource is flat files, running a bulk data update in Data Bridge requires the text files to be in
a suitable format before the Data Bridge application can be used to perform the data transfer into your
model.

When the Specification Files do not already exist, Data Bridge can be used to build them. It can also
be used to validate these Specification Files and the Control File.

Related Topics
• Control Files
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• Organizing an Update
• SAP BusinessObjects Profitability and Cost Management Tables
• Specification Files

2.1 Data Bridge Functionality

There are several functions available to the user in Data Bridge.

These include:
• Model Login/Logout - You can log into and out of models via Data Bridge You can also create and

delete models.

• Specification Wizard - The wizard guides you through the steps needed to create basic SPE

(Specification) and CTF (Control) files for Data Bridge to execute correctly. To create more complex
SPE files, use the "Specification File Editor".

• Specification File Validation - This will perform a validation on the selected SPE file. Only one SPE file
can be validated at a time. If you wish to validate all SPE files you should use Control File Validation.

• Control File Validation - Performs a validation on all SPE files and the selected CTF file.

• Specification File Editor - This allows you to edit the specification file directly without using the
"Specification Wizard".

• Copy Paste facility - You can copy, cut, and paste SPE files from one CTF file to another within Data
Bridge. This allows you to use the same SPE file in multiple Control Files without having to recreate
it for each instance.

• Control File Execution - You can execute the Control file(s) directly from the Data Bridge application.

2.1.1 Restrictions

Data Bridge is primarily intended for routinely updating an existing model with Costs and Driver values
for the next period. It can also be used to build a new model, but you must be aware that Data Bridge
cannot be used to import:
• Books

• Rules

• Security - only a limited amount of security information can be imported

These features can only be built by an Administrator, Model Builder, or Book Builder with the appropriate
security privilege through the client user interface of your application. The Export/Import features of
your application can be used to transfer these features between models.
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Data Bridge Files and Input Data

Data Bridge files include Control files, Specification files, and input data (the datasource).

3.1 Input Data

The input data is the data that you want to import into a model and is specified in the Control File (CTF).
In Data Bridge, datasources include the following:
• Flat files
• SAP Netweaver® Business Warehouse 7.0 SP20 and later
• ODBC (Open Database Connectivity) datasources
• OLE DB for OLAP (Object Linking and Embedding, Database for Online Analytical Processing) or

ODBO datasources
• Oracle databases
• IBM DB2 databases

Flat files
A flat file is usually a plain text file that contains one record per line. Fields in each record are either
separated by delimiters such as commas or tabs or have a fixed length. Data Bridge allows various
formats of flat files; the most commonly used are Comma Separated Values (CSV) files.

For example, the text below is from a CSV file used for importing Activity Driver values into a model:

Activity Driver, All Products, All Customers,Value
# Customers,CO1 Unassigned,Cash & Carry,35,
# Orders,Chairs,Cash & Carry,35,
# Machines,Exec Chairs,CO2 Unassigned,5,
# Orders,Chairs,Mail Order,40,
# Machines,Exec Chairs,CO2 Unassigned,5,

SAP Netweaver® Business Warehouse
Because a Profitability and Cost Management model is an OLAP cube, you can use Data Bridge to
define links to query cubes created in SAP Business Explorer (SAP BEx) from SAP Netweaver®
Business Warehouse 7.0SP02 and above and import both structural and values data into Profitability
and Cost Management models.

To effectively query OLAP cubes to import data into a model, you need to understand how OLAP
terminology and structures map to the terminology and structures that Profitability and Cost Management
uses. The table that follows compares OLAP and Profitability and Cost Management terminology.
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Example

Profitability and
Cost Manage-
ment TermDescription

OLAP
Term

n/an/aDefines how flat file data is repre-
sented in an OLAP cube

Schema

When connecting to Profitability and
Cost Management model cubes
using the MDX Connector, the de-
fault name of the catalog is EPM.

CatalogHolds the metadata that describes
the functionality of the schema and
manages the following:
• cubes
• dimensions
• hierarchies
• levels
• measures
• attributes

Catalog

A Profitability and Costing modelModelA structure that stores data in a
multi-dimensional format that makes
the data easy to analyze. An OLAP
cube consists of aggregated, sum-
marized, and precalculated data.
Cubes consist of dimensions and
measures.

Cube

Responsibility Center, Version, Pe-
riod, Cost Object, Line Item

DimensionA structural component of a cube
that groups data that is related or
of the same type, such as product
lines, departments, or time.

Dimen-
sion

The dimension items Staff Costs,
Travel Expenses, or Car Hire are
all members of the Line Item dimen-
sion.

Dimension itemsSubsets of a dimension. For a cube,
a member is the equivalent of a
value in a relational column. It is the
name or identifier used identify a
data item's position in a cube, for
example Human Resources and
Sales are typical members of a De-
partment dimension. Members are
also known as concepts, attributes,
positions, or items.

Member
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Example

Profitability and
Cost Manage-
ment TermDescription

OLAP
Term

In a Line Item hierarchy, the dimen-
sion item Staff Costs is the parent,
with the child members Salaries,
Overtime, Benefits, and Travel Ex-
penses.

HierarchiesThe parent-child relationships into
which members of a dimension are
organized. A parent is one level up
from a child and usually represents
the consolidation of the child mem-
bers.

Hierar-
chies

A Line Item dimension (Level 0)
could have these levels: Total Ex-
penses (Level 1), Expense Group
(Level 2), and Expense Item (Level
3)

Parents and chil-
dren dimension
hierarchies

The parent-child organizational lay-
ers in a hierarchy. The level number
increments as the level's position in
the hierarchy decreases: Level 0 is
the topmost level, Level 1 is the
next level down, Level 2 is the level
below that, and so on. Levels
specify the level of detail for the
data. The lowest level contains the
most detailed data; the highest level
contains the most summarized data.

Levels

LineItemValues, ActivityDriverVal
ues, ResourceDriverSplits

Grid valuesMeasures are numeric facts that are
categorized by dimension. Mea-
sures can be, for example, key
performance indicators for a busi-
ness, with members such as cost,
profit, or taxes.

Measures

ODBC
You can define links using ODBC (Open Database Connectivity) APIs (application programming
interfaces) to import from datasources such as Microsoft Excel spreadsheets and Access databases.

OLE DB for OLAP (ODBO) datasources
OLE DB or ODBO providers give you access to OLAP databases and OLAP cubes. In Data Bridge,
you can define links to various OLE DB sources such as SQL Server databases and Data Mining
Services data.

You can also import structures and values from one Profitability and Cost Management model into
another.

Note:
Before you can import data from a cube using Data Bridge, you must first define a link to the cube and
you must have installed the specific MDX (MultiDimensional Expressions) provider for your chosen
datasource.
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Oracle and IBM DB2
Data Bridge enables you to import tables from relational databases. You can define links to, for example,
Oracle and IBM DB2 databases as well as importing database tables from one Profitability and Cost
Management model to another.

Restrictions on characters
There are restrictions and warnings on the use of certain characters in input data. Some restrictions
arise from restrictions on URL strings that can be generated by the web features of SAP BusinessObjects
Profitability and Cost Management and others are due to differences in international number formats.

Related Topics
• Links to Datasources

3.1.1 Naming Conventions

Data Bridge supports various separators (delimiters) in text file formats to suit different international
numerical formats, including differences in currency representation. Ensure that the option you choose
does not cause problems with characters that exist in your data. Data Bridge will not import any control
characters that exist in the source data. These special characters should be removed or replaced before
importing using Data Bridge.

Apart from this, you should be aware that the applications supported by Data Bridge have restrictions
on the use of certain characters in object names that can be used by its web features. These restrictions
are not enforced in Data Bridge. As a result, you should avoid introducing the following characters in
book names, model names, and any dimension item names that may be used in URL strings:

Semi-colon;

Colon:

Comma,

Question mark?

Forward slash/

At sign@

Ampersand&

Equal sign=
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Plus sign+

Dollar sign$

Percent%

Some other characters that can cause problems of a different nature are also allowed. You should avoid
introducing control characters because these are liable to produce misleading results in the recipient
application. A similar problem is caused by spaces at the beginning or end of names, because these
names look the same as those without spaces and could lead to misinterpretation of results.

The validation phase of calculation can also object to:
• Strings containing both single and double quotes

• The characters |, [, and ].

3.2 Control Files

A Control File (type CTF file) is used to store the following information:
• Name and location of the SPE (Specification) file
• Information on the datasource as follows:

• If the datasource is a flat file, the name and location of the file
• If the datasource is a database table, the name of the link to the database and the SQL statement

generated to query the database
• If the datasource is a cube, the name of the link to the cube and the MDX statement generated

to query the cube

• File format

The purpose of the control file is to connect the Specification files to the input data. A Control file consists
of one or more records, each of which refers to one Specification file and its associated input data. This
enables you to create one or more output files, each containing several application-specific tables, in
a single operation.

Note:
Many Control Records may reference the same Specification (SPE) file and a datasource.

You can use Data Bridge to generate the CTF files. Alternatively, you can generate the CTF files using
a text editor, and then use Data Bridge to process them.

2010-01-2615

Data Bridge Files and Input Data



3.3 Specification Files

A Specification (type SPE) File is used to define the structure of the data to be imported. This is a template
that specifies how Data Bridge should access a datasource, and converts the individual fields in the
retrieved data into the fields of a specified table.

You can use the "Data Bridge Specification Wizard" to generate the SPE files. Alternatively, you can
generate the SPE files using a text editor, and then use Data Bridge to process them. You can also edit
SPE files using the Data Bridge file editor.

3.3.1 Specification File Statements

This section details all the statements that you can use in a Specification File (SPE). For each statement,
the purpose and syntax are given. Some statements can be used in conjunction with other statements.
In this case, the effect of the combined statements is described.

Note:

All statements, table names, and field names can be specified in upper or lower case, or a mixture.

Where a string is specified, for example <Base>, the characters must be enclosed by delimiters double
quotes, for example, "Base".

Any line starting with an asterisk (*) is treated as a comment and ignored.

The "Specification Wizard" only uses a basic subset of the Specification File Statements used in Data
Bridge — you can edit and modify the SPE file directly to add more complex Specification File Statements.
However, any complex modifcations that are entered manually will be lost if you re-run the wizard to
generate the SPE file.

The statements are grouped into the following categories:
• Table and Field Selection Statements
• Source Data Default Statements
• Source Data Pre-Processing Statements
• Record Statements
• Output Data Post Processing Statements

Related Topics
• Output Data Post Processing Statements
• SAP BusinessObjects Profitability and Cost Management Tables
• Record Statements
• Source Data Default Statements
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• Source Data PreProcessing Statements
• Table and Field Selection Statements

3.3.2 Table and Field Selection Statements

The Table and Field Selection statements include TABLE, TABLE TEMPORARY, ACROSS, LET, and REPEAT.

3.3.2.1 TABLE statement

This statement specifies the destination table for data within the application. The syntax for the statement
is:

TABLE <table_name> <load_method>

where
• <table_name> is the name of one of the tables listed in related topics.

• <load_method> defines how the new data is to be loaded into the model with respect to the existing
data in the model. Because SAP BusinessObjects Profitability and Cost Management holds values
by Version and Period, this adds some complication to the effects produced when loading data into
models created in this application, where the Version and Period specified in records in your input
data have special significance.

The following <load method> options are supported:
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When no load method is specified, data is loaded by the Overwrite and
Append method. “Overwrite” means that existing table records will be
updated with new values from the Input file. “Append” means new records
will be added. In addition, unmatched records will remain unchanged.

blank

For example: TABLE V6-DEPT_ACCT_COST REPLACE

The operation on an SAP BusinessObjects Profitability and Cost Manage-
ment file is complex when the table contains values and your input data
has records that specify particular Versions and Periods. All the records
associated with the specified Versions and Periods are initially deleted,
leaving the records in other Versions and Periods unchanged. The records
in the input data are then created in the table against their specified
Versions and Periods alongside the unchanged records in the unspecified
Versions and Periods.

REPLACE

This option summarizes information as it is read into a table and is only
relevant for tables that hold costs and values. It is useful if the input data
has multiple records for the same set of keys, when the total value has
to be written into the table. Note that existing table records will have their
values included in the total.

For example: TABLE V6-DEPT_ACCT_COST SUMwould summarize the incoming
data and consolidate to the table V6-DEPT_ACCT_COST.

SUM

This option is only relevant for tables that hold costs and values. It allows
you to summarize records in input data that have a common set of keys
and then use the totals to replace the current contents of the table.

For example: TABLE <table_name> SUM REPLACE

Note:
The effects of this option are more complicated when carried out on a
table using input data containing records that specify particular Versions
and Periods. All the records associated with the specified Versions and
Periods are initially deleted, leaving the records in other Versions and
Periods unchanged. The records in the Input file are then created in the
table against their specified Versions and Periods alongside the un-
changed records in the unspecified Versions and Periods.

SUM REPLACE or REPLACE SUM

Remember:
You must have only one TABLE or TABLE TEMPORARY statement.

Related Topics
• SAP BusinessObjects Profitability and Cost Management Tables
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3.3.2.2 TABLE TEMPORARY statement

This statement can be used instead of the standard TABLE statement. This feature is useful when the
datasource is structured in such a way that the data cannot be loaded directly into a table. A temporary
table can be created in an intermediate file, which can then be processed by Data Bridge as a source
file.

The syntax for the statement is:

TABLE TEMPORARY<numberalpha> <numbernumeric>

It creates an extra table with <numberalpha> key alphanumeric fields that will be named ALPHA1 through
ALPHA<numberalpha>, and <numbernumeric> key numeric fields that will be named NUMBER1 through NUM

BER<numbernumeric>. If <numberalpha> is zero, no alphanumeric fields will be generated—similarly for
<numbernumeric>. The maximum number of fields that can be created is 20.

Remember:
You must have only one TABLE or TABLE TEMPORARY statement.

3.3.2.3 ACROSS statement

There must be only one ACROSS statement.

This statement specifies which table fields are to be loaded from the datasource and also the order that
they should be read. It can also be used to define the number of decimal places used in numerical data
and to prefix alphanumeric fields. The syntax for the statement is:

ACROSS <field spec> [, <field spec>]

where
• <field spec> is one of the options detailed in the following table:
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UsageField spec

A field with the default type for the field.<field name>

An alphanumeric field preceded by the string rep-
resented by <Precede>. You can use this statement
to convert a numeric entry into an alphanumeric,
for example the statement:

ACCOUNT CODE(A,’XX’)

would convert the entry 12345 into XX12345.

If a PRECEDE WITH clause is used in a DATA statement
for the same field, it overrides the precede in the
ACROSS statement.

<field name>(A,<Precede>)

A numeric field using the default number of decimal
places that may be specified in a DECIMAL statement

<field name>(N)

A numeric field with the number of decimal places
represented by <decimals>. This overrides any
specification made using a DECIMAL statement,
rounding all numbers to the requested number of
decimal places

<field name>(N,<decimals>)

For example:

ACROSS Department Name, Account Name, VALUE

Every field defined in an ACROSS statement must have a corresponding DATA statement within the RECORD

statement.

Related Topics
• SAP BusinessObjects Profitability and Cost Management Tables

3.3.2.4 LET statement

This statement allows extra fields to be generated from information held in the new data file. The syntax
for the statement is:

LET <field> = <field spec>

where:
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• <field> is one of the field names not specified using ACROSS or REPEAT statements, and
• <field spec> is one of the options detailed under the ACROSS statement.

For example: LET Method Name = Account Name (A,'Meth')

3.3.2.5 REPEAT Statement

If used, this statement must come after the ACROSS statement.

The REPEAT statement can be used to include information in the file that is not present in the datasource
or not generated by a LET statement. The syntax for this statement is:

REPEAT <repeat_field> EVERY <lines> LINES USING <repeat_list>

where:
• <repeat_field> is the field name to be repeated

• <lines> indicates the interval at which the field is to be repeated, expressed as the number of lines

• <repeat_list> is the list of values to be repeated, separated by commas. If there are more input
records than values, the list will begin again and be repeated until all records have a value.

For example, REPEAT VersionName EVERY 1 LINES USING "Actual" creates a record for the Version name,
Actual, in each line of the data.

Caution:

If the <repeat_field> is numeric, then the repeat list should contain numeric values, otherwise unexpected
values will appear in the model.

You can put the REPEAT statement over several lines by using & at the end of a line after a comma (,).

Note:

• All fields specified within ACROSS, LET and REPEAT statements must match the fields defined in the
table specified within the TABLE statement.

• All key and numeric fields in the table must be specified in an ACROSS, LET, or REPEAT statement. Any
alphanumeric field which is not specified will have *MNF* inserted, which stands for Match Not Found.

3.3.3 Source Data Default Statements

The Source Data Default Statements are SCALE, DECIMAL, PERIOD, BAD NUMERICS, TAB, TREAT DELIMITER,
NEGATIVES, and POSITIVES.
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3.3.3.1 SCALE statement

These are alternatives for the same statement, which specifies a default scaling to be applied to all
numeric fields. The following options can be used:

UsageOption

Scale by the specified numberSCALE<number>

Scale by 1 (or apply no scaling)SCALE U

Scale by 1,000SCALE K

Scale by 1,000,000SCALE M

Scale by 1,000,000,000SCALE B

In each of these options, you can use IN instead of SCALE.

Note:
Scaling is the equivalent of division. For example, if K scales the input number 123, then the result will
be 0.123.

For example: SCALE 4 divides the input number by 4. If the input number is 123, the result is 30.75.

3.3.3.2 DECIMAL statement

This statement is used to specify the maximum number of decimal places to be used in numeric fields.
The syntax for this statement is:

DECIMAL <number>

where:
• <number> is a whole number in the range 0 to 15. All numeric entries will be rounded to the specified

number of decimal places.

If you do not include a DECIMAL statement in your specification file, the system will assume a default
value of 10.

For example: DECIMAL 4
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3.3.3.3 PERIOD statement

This statement is used to specify the Period into which the data should be placed. The syntax for this
statement is:

PERIOD '<string>'

where:
• <string> is the Period name you wish to load into. If it does not currently exist, it will be created

automatically. This PERIOD statement will stay in effect until the next PERIOD statement is processed
in the current specification file.

If a “Period” name is not specified, data will be loaded into the Current “Period”.

For example: PERIOD 'July'

3.3.3.4 BAD NUMERICS statement

The BAD NUMERICS statement defines the value to be used to replace any invalid numbers that may occur
in the input file. The options you can use are:

UsageOption

Replace all invalid numerical entries with -0. This
is the default.

BAD NUMERICS ZERO

Replace all invalid numerical entries with the
number represented by <value>.

BAD NUMERICS<value>

Note:
When the application reads -0, it treats it as 0.

3.3.3.5 TAB statement

You can use this statement if the datasource is a flat file using tabs as delimiters. This statement
specifies the default tab stops in the source file. Data Bridge will automatically convert tab characters
in the source file to the appropriate number of character spaces according to the tab stops.
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For example, TAB 10 will set tabs at 10, 20, 30, and so on.

Unless you specify otherwise, default tab stops will be set to 8.

Note:
If a TREAT TAB DELIMITER statement has been used in the specification file, any TAB statement will be
ignored.

3.3.3.6 TREAT DELIMITER statement

This statement specifies the character to be used as a delimiter in delimited files. The syntax is:

TREAT <char> DELIMITER

where <char> represents the delimiter character.

For example, the statement TREAT ';' DELIMITER indicates that a semicolon is to be used as the delimiter.

The default delimiter is a comma, which is used unless it is overridden by a TREAT DELIMITER statement.

Note:
The statement TREAT TAB DELIMITER will use TAB as the delimiter. If you use this, Data Bridge will ignore
any TAB statements in the specification file.

3.3.3.7 NEGATIVES statement

This statement specifies the way that negative numbers are represented in the datasource. The syntax
is:

NEGATIVES '<string>' BEFORE

NEGATIVES '<string>' AFTER

For example, the statement:

NEGATIVES 'CR' AFTER

interprets the entry 1.70 CR or 1.70cr in the source file as -1.7.

3.3.3.8 POSITIVES statement
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This statement specifies the way that positive numbers are represented in the datasource. The syntax
is:

POSITIVES ‘<string>’ BEFORE

POSITIVES ‘"<string>"’ AFTER

For example, the statement:

POSITIVES 'DB' AFTER

would interpret the entry 1.70 DB or 1.70db in the source file as 1.7.

3.3.4 Source Data PreProcessing Statements

The Source Data PreProcessing statements include IGNORE LINES and IGNORE CHARACTER.

3.3.4.1 IGNORE LINES statement

This statement specifies lines in the input data that are to be ignored by Data Bridge. The following
options can be used:

UsageOption

Ignore all blank linesIGNORE LINES

Ignore all lines containing the text string represented by xxxIGNORE LINES 'xxx'

Ignore all lines containing the text string represented by xxx at the character
position indicated by <col>

IGNORE LINES 'xxx' AT

<col>

3.3.4.2 IGNORE CHARACTER statement

This statement allows you to specify characters in the input data that are to be ignored by Data Bridge.
You can use one of the following options:
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UsageOption

Ignore the specified character wherever it appears in the data fileIGNORE CHARACTER 'x'

Ignore the specified character when it appears at column <col>IGNORE CHARACTER 'x' AT

<col>

Ignore the specified character when it occurs in a numeric string read from
the data file

IGNORE CHARACTER 'x' IN

NUMBERS

3.3.5 Record Statements

The actual data in the datasource is converted to the fields in the ACROSS statements using a record
block.

The syntax for a record block is:

RECORD <record name><record statement> [, <record statement>]
END ON <end condition>

where:
• <record name> is the unique record structure name, and must not begin with a numeric character.

The use of unique names allows Record blocks to be called from other Record blocks—see below.
• <record statement>[, <record statement>] represents the set of statements controlling how the

input data is processed. A combination of options listed in the following table can be used:

The source file is read from the current pointer, and for DATA and DUPLICATE the value is placed in the
next field listed in the ACROSS statement.

UsageRecord Statement

Read up to the next delimiter as an alphanumeric field.DATA (A*)

Read the next <n> characters as an alphanumeric field. These <n> char-
acters should not contain the comma character, otherwise the output will
be incorrect.

DATA (A<n>)

Read up to the next occurrence of <string> as an alpha field. These
characters should not contain the comma character, otherwise the output
will be incorrect.

DATA (A'<string>')

If PRECEDE WITH is added to a DATA statement , the resultant field is preced-
ed with the string <precede>. This overrides any <precede> string used in
an ACROSS statement for the same field. For example: DATA (A5) Precede

With DEPT

DATA (A….) PRECEDE WITH

<precede>

Read up to the next delimiter as a numeric field.DATA (N*)
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UsageRecord Statement

Read the next <n> characters as a numeric field.DATA (N<n>)

Read up to the next occurrence of <string> as a numeric field.DATA (N'<string>')

If IN <scale> is added to a DATA statement, the number is scaled by the
factor <scale>. If no IN <scale> is used, the number is scaled according
to the SCALE statement. Any invalid numbers will be set according to the
BAD NUMBERS statement.

DATA (N….) IN <scale>

Copy the value read from the previous record for the field, then skip over
the next <n> characters

DUPLICATE SKIPPING<n>

CHAR

Read the new Period name up to the next delimiter and make all subse-
quent data load for the new Period

PERIOD (A*)

Read the next <n> characters, or up to the delimiter, and treat them as
the new Period name, making all subsequent data loaded for the new
Period. (A0) is treated as (A*).

PERIOD (A<n>)

Read up to the next occurrence of <string> and make all subsequent
data load for that Period.

PERIOD (A'<string>')

Find the next line containing the specified character string (located at the
defined position in the line) leaving the internal pointer at the start of the
line. AT 0 is treated as AT 1.

LOCATE '<string>' [AT

<pos>]

Skip over the next <n> characters.SKIP<n> CHARACTERS

Skip over the next <n> delimiters.SKIP<n> DELIMITERS

Skip over the next <n> lines.SKIP<n> LINES

Skip to the end of the current input line.SKIP TO EOL

Skip to the next delimiter.SKIP TO DELIMITER

Skip to the start of the file.SKIP TO SOF

Skip to the start of the line.SKIP TO SOL

Skip to the next occurrence of the string <string> in the current line.SKIP TO '<string>'

Sub-run the record block specified by <record name>.<record name>

A DATA or DUPLICATE statement places the value in the next field in the ACROSS statement.

DATA (.*) statements are usually used with delimited files. DATA (.<n>) and DATA (.’<string>’)

statements are usually used with fixed format files.

If the next Table field is a numeric field, the associated DATA statement must read numeric values.

When using a PERIOD statement, if the Period does not exist in the model, it is created if updates of the
mdoel are allowed.
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<end condition> is the condition used to denote the end of the record. The options are given in the
following table:

UsageEnd condition

Stop when the end of the file is reached.EOF

Always stop with the pointer at the start of the current line.SOL

Stop when the quantity of records represented by <number> has been read.<number> RECORDS

Stop when the indicated character string occurs anywhere in the line.'<string>'

Stop when the indicated character string does not occur anywhere in the line.'<string>' NOT IN

LINE

Stop when the indicated character string occurs at character <n> in the line.'<string>' AT <n>

Stop when the indicated character string does not occur at character <n> in the
line.

'<string>' NOT AT

<n>

Restriction:
The length of a record in the input data must not exceed 4095 characters; any subsequent characters
are ignored.

3.3.5.1 Record Block

Using a single Record block enables Data Bridge to process input data in which the records containing
data to be transferred are identical, and where each record (or set of records) relates to one record in
the table. If the input data is not structured in this manner, you need to define a set of Record blocks
that will process the data in the required manner.

The following rules apply when defining multiple Record blocks:
• A Record block must be defined before it is called.

• A Record block can be called from one or more other Record blocks.

• Up to 8 levels of calling can be used.

• The Record block that is actually executed is the one that is defined last.

• A Record block can contain either no DATA / DUPLICATE statement or the same number as in the
ACROSS statement.
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3.3.5.2 Pointer Position

As the structured data is read by Data Bridge, an internal pointer tracks the exact position within the
file that is about to be read. The statements within the Specification file control this pointer.

For example, the following statement:

SKIP 6 CHARACTERS

positions the pointer at the seventh character from its current location, ignoring the first six characters.

The full effects of statements on the pointer are detailed in the following tables:

Pointer positionRecord Statement

Read the next <n> characters and place the pointer at the first subse-
quent character. If there are insufficient characters in the current line,
read to the end of the line and place the pointer at the end of the line.
If there are insufficient characters before the terminator, place the
pointer at the terminator.

DATA (A<n>) and DATA (N<n>)

Read up to <string> and place the pointer at the start of the string.DATA (A'<string>') and DATA

(N'<string>')

Advance the pointer by <n> characters and place the pointer at the
first subsequent character. If there are insufficient characters in the
current line, place the pointer at the end of the line.

DUPLICATE SKIPPING <n> CHAR

Place the pointer at the beginning of the first line meeting the character
string requirements. The current line is included in the check for the
string criteria.

LOCATE '<string>' [AT <pos>]

Advance the pointer by <n> characters. If there are not sufficient
characters in the current line, place the pointer at the end of the line.

SKIP<n> CHARACTERS

Ignore any characters unread in the current line, count the next <n>
end of line markers and place the pointer at the start of the next line.
If there are insufficient lines, an error message will be reported.

SKIP<n> LINES

Equivalent to <n> occurrences of SKIP TO DELIMITER.SKIP<n> DELIMITERS

Move the pointer to the end of the current input line.SKIP TO EOL

Move the pointer to the start of the current input line.SKIP TO SOL
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Pointer positionRecord Statement

Move the pointer to the start of the source file.SKIP TO SOF

Move the pointer to the start of the <string>. If there is no <string>

in the rest of the current line, the pointer is placed at the end of the
line.

SKIP TO '<string>'

Move the pointer to the next delimiter or end of the line if there are no
further delimiters.

SKIP TO DELIMITER

Pointer positionEnd condition

Check whether the pointer is at the end of the data file. End if it is, otherwise
move to the beginning of the next line.

EOF

Move to the beginning of the current line.SOL

Move to the beginning of the next line, ignoring the end of line marker and any
other characters in the current line. Check whether the terminate condition is
satisfied and stop if it has. Otherwise, continue to process the next line.

All other end condi-
tions

3.3.6 Output Data Post Processing Statements

The Output Data Post Processing statements include LOOKUP and IGNORE RECORDS.

3.3.6.1 LOOKUP statement

This statement must come after the TABLE statement and not within a RECORD statement.

This statement is used to allow names in the input data to be matched to those in the database. The
syntax for this statement is:

LOOKUP <fieldname> FROM <file>

or

LOOKUP <fieldname> FROM <file> LOWERCASE

where:
• <fieldname> is the field name in the table.

• <file> is the name of a comma (or semicolon) separated file with two fields—the first being the
value in the source file and the second being the value you wish to load into the table field.

2010-01-2630

Data Bridge Files and Input Data



• LOWERCASE matches the field in the source with the lookup file, irrespective of case.

If the <file> contains spaces, enclose it in double quotes.

For example:

LOOKUP Method Name from "C:\Convert Table.csv" LOWERCASE

LOOKUP statements are performed prior to IGNORE statements.

Note:
In the lookup file the text is case-sensitive, and spaces are significant.

Restriction:
LOOKUP statements must occur before RECORD statements and after all ACROSS, FILL, LET, and REPEAT

statements.

3.3.6.2 IGNORE RECORDS statement

This statement must come after the TABLE statement and not within a RECORD statement.

This statement is used to remove the unwanted lines (Records) from the Output File. The syntax for
this statement is:

IGNORE RECORDS WHERE <field selection>

where <field selection> is a series of field pairs. A field pair consists of field name and field values
strings in delimiters. You can have up to nine field pairs and the record will only be ignored when all
field pair selections match.

For example:

IGNORE RECORDS where DEPARTMENT NAME 'D876' Account Name
'Acc5'

You can have more than one IGNORE RECORDS WHERE statement.
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Organizing an Update

Data Bridge is primarily intended for routinely updating an existing model with Costs and Driver Values
for the next “Period”. It can also be used in many other ways for moving data into models, although the
complexity involved in data preparation can mean there are easier ways of accomplishing certain tasks.
For example, if you are transferring data between models, the Export/Import features provided in the
applications have been designed to cover all likely options.

When using Data Bridge you should be aware that the integrity of your model could easily be
compromised by incorrect data. This means that you should be sure to create a backup before starting
and you must check your model after completion. If you are updating costs and values in an existing
model on a regular basis, your procedures will be well established and your data will target specific
items in the model structure that are easy to verify. If, however, you are creating structures, any mistakes
in your data could produce peculiarities that might take you some time to resolve.

When you build a new model, you must first build its Dimensions and their Hierarchies, then its
Assignments, and finally you must input its Costs and Driver Values. The cleanest method for achieving
this is through the user interface provided in your application. You can see structural items as you create
them, and have views of their hierarchies and the assignments you specify. Thereafter you can use
Data Bridge to set up procedures that support periodic updates of costs and values.

Database tables can be used by Data Bridge to define a model. These identify the sequence of steps
involved in building a new model. Any partial update to an established model at any of these stages
requires an understanding of its current state to ensure the update performs in the way you expect.

Related Topics
• Assignments
• Import Methods
• Restrictions

4.1 Structure

When planning how to build the dimension structures of your model, you should initially consider doing
it through the user interface of your application, because this will guarantee the integrity of your database.
Using Data Bridge for this purpose is a great deal more complex than typing, but if you need to follow
this course you must first understand the composition of the database tables that support its dimensions.

Whereas all SAP Business Objects Profitability and Cost Management applications have a different
set of dimensions; all dimensions share the same structure. Most of the dimensions have a multi-level
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main hierarchy and several also have an attribute hierarchy. The “Currencies” dimension is unusual
because it has a flat structure with no attribute hierarchy. An attribute item defines a characteristic that
you wish to associate with particular items in the main hierarchy. Attribute items can be groups in the
same way as items in the main hierarchy, so both hierarchies are multi-level. Main hierarchy items can
have several attributes, so they can belong to several attribute groups. You can find a full description
of dimension hierarchies in the SAP BusinessObjects Profitability and Cost Management User Guide
or the F1 Help of the application.

Using Data Bridge to introduce structure via a flat file to your model involves composing input files in
a detailed format.

Related Topics
• Attribute Flags
• Building Bulk Hierarchies
• Building Hierarchies
• Bulk Tables
• Consolidation Types
• Data Aliases
• Dimensions
• The ParentChild Table

4.2 Building Hierarchies

Dimension structures in an application are defined through the ParentChild table.

Dimension structures are built up in a three-phase process that involves detailed preparation of Par
entChild input files if you choose to use flat files to import structural data. The stages for implementing
the standard import method are:
• Build a Main Hierarchy
• Build an Attribute Hierarchy
• Build Attribute Assignments

Two methods of import are provided—the standard method is sufficient for hierarchies of moderate
size, but an alternative bulk method exists for handling large hierarchies (greater than 40,000 items).
Both methods accept the same data layouts for their ParentChild input data. Bulk import is much quicker
than the standard import method but performs only minimal validation.

Related Topics
• Building Bulk Hierarchies
• The ParentChild Table
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4.2.1 Building a Main Hierarchy

This is the first stage of the recommended process for building dimension structures in a model and is
only concerned with defining the structure of items in the Main Hierarchy of all the dimensions in your
model. If you are using flat files to build a structure, your main task is to create the ParentChild input
data that represent your intended hierarchies. You then can use Data Bridge to create the associated
Specification file and the Control file that drives the import.

Consider the Main Hierarchy for “Responsibility Centers” shown below:

The ParentChild CSV file that you need to construct to obtain this structure is shown below:

Consolidation
TypeAttribute FlagsChildParentDimension

+10Responsibility Cen-
ter One

Group Responsibility
Centers

“Responsibility
Centers”

~10Responsibility Cen-
ter Two

Group Responsibility
Centers

“Responsibility
Centers”

-10Responsibility Cen-
ter Three

Group Responsibility
Centers

“Responsibility
Centers”

Note:
Only three records are required to define the four items in the hierarchy. The Group item is created
automatically at the top level of the hierarchy when the first record is imported. The Attribute Flags all
have the value 10 which specifies all records as:
• Parent is a Main Hierarchy Group
• Child is a Main Hierarchy Group

This Attribute Flag value is a sterile value that is suitable for all records defined at this stage. Although
Child items are apparently defined as Groups, they will appear as children and only become groups if
additional records specify them as Parents with a specific Child.

The Consolidation Type applies to the Child item specified in the record. All the Main Hierarchy
Consolidation Types are demonstrated by this example.

You should check your results after this stage to ensure you have produced the structure you wanted,
because this gives the opportunity to recover from errors in your data with the minimum disruption.
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Note:

The Parent and Child names used in the input data records are defined across all Data Aliases defined
in your model.

After building the Main Hierarchy, the second stage of the process for building structures is to build an
Attribute Hierarchy.

Related Topics
• Attribute Flags
• Building an Attribute Hierarchy
• Consolidation Types
• Data Aliases
• The ParentChild Table

4.2.2 Building an Attribute Hierarchy

This is the second stage of the recommended process for building dimension structures in a model and
is solely concerned with defining the structure of items in the Attribute Hierarchy of all the dimensions
in your model. The main task you have to perform is to create the ParentChild input data that represent
your intended Attribute Hierarchies. (Before building an Attribute Hierarchy, the first stage of this process
is to build a Main Hierarchy.)

Consider the Attribute Hierarchy for “Responsibility Centers” shown below:

If you are using flat files to build the structure, the ParentChild CSV file that you need to construct to
obtain this structure is shown below:
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Consolidation
TypeAttribute FlagsChildParentDimension

OR15Overseas Groups“Responsibility Center At-
tributes”

“Responsibility
Centers”

15FranceOverseas Groups“Responsibility
Centers”

15USOverseas Groups“Responsibility
Centers”

The Attribute Flags all have the value 15 which specifies all records as:
• Parent is an Attribute Hierarchy Group
• Child is an Attribute Hierarchy Group

The Attribute Flag value of 15 is a sterile value that is suitable for all records defined at this stage.
Although Child Attributes are apparently defined as Groups, they will appear as children and only
become groups if additional records specify them as Parents with a specific Child.

Consolidation Type applies to the Child item specified in the record and is only valid for Attribute Groups
in a model. As a result, Consolidation Type has been left blank for the leaf items in our example. The
first record is only included to demonstrate how to set the Consolidation Type of an Attribute Group. In
fact, the Consolidation Symbol shown here is the default for Attribute Groups and the record could have
been omitted, but it also demonstrates how to define an Attribute Group under the root item of the
Attribute Hierarchy. This is shown in the Parent Field as “Responsibility Center Attributes”. The other
Dimension Attribute Hierarchies have root items that are named in the same manner, for example,
“Activities” has “Activity Attributes” and “Periods” has “Period Attributes”.

Note:
If the first record was omitted, the Attribute Group would be created automatically by the record that
follows it.

You should check your results after this stage to ensure that you have produced the structure you
wanted, as this gives the opportunity to recover from errors in your data with the minimum disruption.

Note:
The Parent and Child names used in the input data records are defined across all Data Aliases defined
in your model.

After building an Attribute Hierarchy, the third stage of the process for building structures is to build
Attribute Assignments.

Related Topics
• Attribute Flags
• Building a Main Hierarchy
• Building Attribute Assignments
• Consolidation Types
• Data Aliases
• The ParentChild Table
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4.2.3 Building Attribute Assignments

This is the third and final stage of the recommended process for building dimension structures in a
model and is solely concerned with defining the Attributes possessed by the Dimension Items in your
model. The main task you have to perform is to create the ParentChild input data that represent your
intended Attribute Assignments. Before building Attribute Assignments, the first two stages of this
process are to build a Main Hierarchy and an Attribute Hierarchy.

Consider developing further the Main and Attribute Hierarchies for Responsibility Centers that were
created by the first two stages of this process into the form shown below:

If you are using a flat file to build the structure, the ParentChild CSV file that you need to construct to
produce this structure is shown below:

Consolidation TypeAttribute FlagsChildParentDimension

12Responsibility Cen-
ter One

France“Responsibility
Centers”

12Responsibility Cen-
ter Two

US“Responsibility
Centers”

The Attribute Flags can all have the value 12 which specifies all records as:
• Parent is an Attribute Parent
• Child is a Main Hierarchy item

This Attribute Flag value is a sterile value that is suitable for all records defined at this stage.

Note:
The Child field must specify an item and not a group. This is because Attributes cannot have Group
items as children; only leaf items.

Consolidation Type applies to the Child item specified in the record and is only valid for Attribute Groups
in a model. As a result, Consolidation Type has been left blank for the child items in our example.

Note:
The Parent and Child names used in the input data records can be any Data Alias names in your model.
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You will now have completed the process for constructing your dimension hierarchies. You could have
chosen to build all dimensions at once or alternatively could have built them individually. You should
have checked your results at each stage to ensure you have produced the structure you wanted,
because this gives the opportunity to recover from errors in your data with the minimum disruption.

Related Topics
• Attribute Flags
• Building a Main Hierarchy
• Building an Attribute Hierarchy
• Consolidation Types
• Data Aliases
• The ParentChild Table

4.3 The ParentChild Table

This table defines the hierarchical structure of all the dimension items in a model. It holds the following
fields:
• DimensionName – The name of a dimension as defined in your application in the Dimensions sidebar.
• ParentName – The Default Alias name of an item
• ChildName – The Default Alias name of an item
• Attribute Flags

• Consolidation Types

4.3.1 Attribute Flags

To understand the role of Attribute Flags you should consider the example below, which shows a
“Responsibility Centers” dimension containing a Main Hierarchy and Attribute Hierarchy with simple
structures. More detail on these structures can be found in the Profitability and Cost Management User
Guide.
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The Main Hierarchy contains one Group or parent and three leaf items or children. The Attribute Hierarchy
contains one Group Attribute that has two Attribute items each referencing a leaf item in the Main
Hierarchy.

Attribute Flags define the relationship between a hierarchy item and its immediate parent in either the
Main or Attribute Hierarchy structure. They are binary coded numbers that represent the different types
of relationship in the following manner:
• 1 - Child is an Attribute—when not set Child belongs to Main Hierarchy
• 2 - Child is a Parent (subgroup)—when not set Child is a leaf item
• 4 - Parent is an Attribute—when not set Parent belongs to Main Hierarchy
• 8 - Parent is a Parent (Always true)

When you map the attribute flags in the "Field Mappings" screen of the "Data Bridge Specification
Wizard", the following options are available:
• 10 (Main Hierarchy)
• 12 (Attribute Assignment)
• 15 (Attribute Hierarchy only)

The numbers 10, 12, and 15 represent the sum of the binary coded attribute flags described above.
So, for example, when you select a value of 12 (Attribute Assignment), you are specifying that the
Parent is an Attribute (4) and that the Parent is a Parent (8) and 4 + 8 = 12.

Related Topics
• Building an Attribute Hierarchy

4.3.2 Consolidation Types

Consolidation Types are identifiers that indicate how the value of an item should contribute to its group
total. Each Consolidation Type has its own symbol or icon that is used to represent its set state.
Consolidation operates differently in the Main Hierarchy and Attribute Hierarchy and these differences
are identified below:
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Main Hierarchies

Add the value of this item to the group total.Add

Subtract the value of this item from the group total.Subtract

Exclude this value from the group total.Don’t Consolidate

Attribute Hierarchies

Sum all values for all items in all sub groups.All

Sum values for items that appear in all sub groupsCommon

Do not sum any values that appear in sub groups.Don’t Consolidate

When viewing an XML file, the Consolidation Types for Attributes will appear as follows:

Consolidation SymbolConsolidation Type

ORAll

ANDCommon

~Don’t Consolidate

Related Topics
• Building Hierarchies

4.3.3 Data Aliases

Giving a Dimension item a name is slightly more complex than you might expect, as SAP BusinessObjects
Profitability and Cost Management allows more than one set of names to be assigned to items. Each
set is a Data Alias group, and there are three built-in Data Aliases groups as shown below. Apart from
these you can also create user-defined Data Aliases groups. These are defined at database level and
are valid across all models in your database. The built-in groups are:
• Default Alias – The name you first assign when you rename a new item
• Codes – provided for holding Ledger Code mappings
• EPO Code – the system name that is assigned when the item is created. (Note that if you copy a

model this code will be different in the copy)

By default, when an item alias has not been given a specific name it assumes the Default Alias name.
All names defined under these groups and any additional user-defined groups are held as individual
records in the Alias table.
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You can define Data Alias names for both Main Hierarchy and Attribute Hierarchy items. To do this,
you have to set up datasouces and Specification Files for the Alias data table, and need to understand
its record structure.

Note:
To overcome performance problems associated with handling large hierarchies, you can use a bulk
import process. This imports to the Alias_Bulk table rather than the standard Alias table. These both
have the same field layout, so input data for both processes is the same.

Related Topics
• Alias Table Fields

4.3.3.1 Alias Table Fields

The fields in the Alias table have the following significance:
• Dimension Name – Names as defined in your application in the Dimensions sidebar.
• DataAliasName – Any Data Alias name, for example Default Alias.
• Attribute Flag – (Optional). In an operational model, this holds details about the hierarchical

characteristics of the item this record refers to (0 – Main hierarchy; 1 – Attribute Hierarchy; 2 – Group;
3 – Attribute Group). When you are defining Alias names, this field should be left blank in a datasource.
These characteristics should be defined through the Attribute Flags field of the ParentChild table.

• Alias – The name of this item under the specified Data Alias above.
• Default Alias – The Default Alias name (identifies an item by its default name).
• Attribute Info – Optional (This should be left blank in your Input records as it only has operational

significance).
• Status Info – Optional (0 – Normal; 1 – Locked; 2 – Current; 3 – Current & Locked). Should be left

blank in your Input records.

When preparing input data that define new Alias names for items, you may leave the optional fields
blank. The item to which a record refers will already exist with a Status and a defined set of Attributes.
Because Alias input data can have several records referring to the same item, these fields are best left
undisturbed by the import process.

Related Topics
• Building Bulk Hierarchies
• Data Aliases
• Attribute Flags
• Consolidation Types
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4.4 Building Bulk Hierarchies

A bulk method is provided for importing large hierarchies (greater than around 40,000 items). This is
much quicker for building large hierarchies than the standard method, but achieves this by minimal
validation of your input data.

As a result, the integrity of your model is more exposed and you are advised to take backups and check
the validity of both your input data and your resulting hierarchy carefully. The method uses the Par

entChild_Bulk and Alias_Bulk tables rather than the ParentChild and Alias tables provided for standard
imports. The fields in these bulk tables are the same as those of the standard tables, so data formatting
of your input data is the same.

ParentChild_Bulk imports are intended for the initial loading or update of a large hierarchy. This includes
updates where the input data is large or the existing hierarchy is large. The minimal validation that
provides the improved performance can produce some special cases in the handling of your input data.
To ensure that you avoid potential problems you are advised to run your update in at least two passes:
• Initial Input Pass: Define all parent items at root level in the main hierarchy
• Subsequent Passes: Define your intended Parent/Child links

Bulk alias handling is more straightforward because aliases have a direct association with their dimension
items. These will operate on an add or replace basis.

Where major restructuring of an existing large hierarchy is required you should consider using a special
bulk replace mechanism that uses the ParentChild_Bulk_Replace table.

Related Topics
• Bulk Tables
• Restructuring Large Hierarchies

4.4.1 Restructuring Large Hierarchies

The standard import mechanism operating in Replace mode will encounter performance problems when
restructuring larger hierarchies. These can be overcome by a bulk replacement feature that uses the
ParentChild_Bulk_Replace table. Its format is the same as the standard ParentChild table, so formatting
of input data is the same.

To obtain adequate performance with potentially large hierarchies (whether the majority of size already
exists within your model or is contained in your input data), this procedure initially reorganizes the
hierarchy before running the bulk replace.
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Remember:
You are strongly advised to back up your model before making any alterations to the hierarchical
structure.

4.4.1.1 To Restructure Large Hierarchies

1. All Attribute records are removed.
2. All items are made children of the root node in the Main hierarchy.
3. The ParentChild_Bulk_Replace Input data is then validated on child field—if an item does not exist

it is added. The Input Data supplied in the last phase of this process will determine to what extent
the rebuild is performed. Because all Attribute records were deleted, they have to be redefined. All
Attribute Consolidation groups also have to be recreated. This can be achieved in a number of
passes according to preference, using the ParentChild_Bulk update process.

Note:
Bulk update processes do not provide for deletion of items. This can be performed as part of the model
validation process that should follow these updates.

Related Topics
• Replace

4.4.2 Bulk Tables

The bulk tables ParentChild_Bulk, ParentChild_Bulk_Replace, and Alias_Bulk should be used when
updating very large hierarchies.

They have exactly the same structure as their standard equivalents: the ParentChild and Alias tables.
They are provided to increase the speed of the import, which is achieved by minimal validation on the
data being imported.

It is therefore very important to take backups and to check your input data for accuracy before starting
the import.

4.5 Assignments

To incorporate assignments into your model, you should always consider doing it through the user
interface of your application, because this will guarantee the integrity of your database. This is also
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your sole means to verify that you have applied your assignments correctly, so is the ideal choice for
this process.

Using Data Bridge is a great deal more complex than typing, but if you need to follow this course you
must first ensure that your model already contains all the dimensions required by the assignment
functions.

The fields in these tables generally specify dimension item names that should already exist in your
model. These can be names defined under any of your existing Data Aliases. Where fields have a range
of options, you should consult the relevant tables to check what is permissible.

.

Related Topics
• Data Aliases
• Dimensions
• SAP BusinessObjects Profitability and Cost Management Tables

4.6 Values

Data Bridge supports the bulk update of values and costs that are normally required by a model at the
start of each new period. Once the formats for the input data have been defined, their Specification
Files should remain unchanged from one use to the next, which is ideal for this routine procedure.

The database tables that support values and costs differ slightly by application. Their fields generally
specify dimension item names that should already exist in your model. These can be names defined
under any of your existing Data Aliases.

Note:

• Tables can be updated in any order; with the exception of ResourceDriverValues and ResourceDriver

Splits when you specify “Splits” as percentages. If ResourceDriverValues do not exist when the
percentages are calculated, there is no total value for the percentage to operate against.

• If a value is left blank in your input data, this is interpreted as the value zero. If you specify both
values and percentages in your input data and indicate in your Specification File that both of these
are to be read, the percentage value is applied if a value is zero. Otherwise, the value takes
precedence over the percentage value.

Related Topics
• Data Aliases
• Dimensions
• SAP BusinessObjects Profitability and Cost Management Tables
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4.7 Import Methods

There are four different methods for importing data into Data Bridge that will affect the way data is
handled. These methods can be selected through the Data Bridge Wizard, which creates equivalent
TABLE commands in your specification file.
• Overwrite and Append (The default method)
• Replace

• Replace and Sum

• Sum New and Existing

To explain how the different methods work, consider the following data files:

File 1:

QuantityProductRecord Number

5Exec Chairs1

6Exec Desks2

4Chairs3

5Desks4

3Tables5

File 2:

QuantityProductRecord Number

6Chairs1

7Desks2

5Tables3

8Drawer Units4

9Chairs5

7Desks6

The second file does not contain any Executive Chairs or Executive Desks, has an additional product
of Drawer Units, and has two entries each for Chairs and Desks.

Related Topics
• Specification Wizard – Table Setup
• TABLE statement
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4.7.1 Overwrite and Append

When the Overwrite and Append method is selected, after importing the second file the result would be:

Record NumberQuantityProduct

File 1, record 15Exec Chairs

File 1, record 26Exec Desks

File 2, record 59Chairs

File 2, record 67Desks

File 2, record 35Tables

File 2, record 48Drawer Units

As the name of the method suggests, the original data has been overwritten, and new data has been
added.
• Because the second file contains no reference to Exec Chairs and Exec Desks, the data remains

unchanged.
• Chairs, Desks, and Tables all contain entries in the second file, so their data has been overwritten

with the quantities from the second file. The quantities for Chairs and Desks are overwritten a second
time because of additional entries within the second file. In this instance the last entry for each is
used.

• Drawer Units is a new item and so has been added into the record.

4.7.2 Replace

When the Replace method is selected, after importing the second file the result would be:
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Record NumberQuantityProduct

Exec Chairs

Exec Desks

File 2, record 59Chairs

File 2, record 67Desks

File 2, record 35Tables

File 2, record 48Drawer Units

As the name of the method suggests, the original data has been replaced with the new data
• Because the second file contains no reference to Exec Chairs and Exec Desks, the quantity is

replaced with a blank; there is no change to the Product hierarchy.
• Chairs, Desks, and Tables all contain entries in the second file, so their data has been overwritten

with the quantities from the second file. The quantities for Chairs and Desks are overwritten a second
time because of additional entries within the second file. In this instance the last entry for each is
used.

• Drawer Units is a new item and so has been added into the record.

4.7.3 Replace and Sum

When the Replace and Sum method is selected, after importing the second file the result would be:

Record NumberQuantityProduct

Exec Chairs

Exec Desks

File 2, record 1 + file 2, record 515Chairs

File 2, record 2 + file 2, record 614Desks

File 2, record 35Tables

File 2, record 48Drawer Units

As the name of the method suggests, the original data has been overwritten. Where there is more than
one entry for an item, the quantities have been added together and new data has been added.
• Because the second file contains no reference to Exec Chairs and Exec Desks, the data remains

unchanged.
• Chairs, Desks, and Tables all contain entries in the second file, so their data has been replaced with

the quantities from the second file. This time however, because Chairs and Desks have more than
one entry in the second file, the quantities are added together.
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• Drawer Units is a new item and so has been added into the record.

4.7.4 Sum New and Existing

When the Sum New and Existing method is selected, after importing the second file the result would be:

Record NumberQuantityProduct

File 1, record 15Exec Chairs

File 1, record 26Exec Desks

File 1, record 3 + File 2, record 1 + File 2, record 519Chairs

File 1, record 4 + File 2, record 2 + File 2, record 619Desks

File 1, record 5 + File 2, record 38Tables

File 2, record 48Drawer Units

As the name of the method suggests, the original data has been added to the data from the second
file. That is, ALL entries for each product are added together, whether new or existing.

Related Topics
• TABLE statement
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Using Data Bridge

When you start the Data Bridge application the "Welcome" dialog box appears.

This dialog allows you access to the following options:
• Blank Control File – This option allows you to create a new control file. The Data Bridge interface

will open and you can create your new CTF file.
• Create a new Data Bridge control file and specification file using the Wizard – This option allows

you to create a new control file and starts the Data Bridge Specification Wizard.
• Open an existing Data Bridge Control File – This gives you two options. You can either select a file

from the list of the most recently used Control Files that displays in a pane at the bottom of the
screen, or select the More Files option. This option opens the standard Windows "File Open" dialog
box to allow you to browse through folders to the Control File you require.

5.1 Data Bridge Interface

The Data Bridge interface allows you to display and manage your files. It is a customizable interface
that gives you control of the workspace. The interface incorporates standard Windows Minimize and
Maximize buttons and is also resizable.

The Data Bridge interface includes the following features:
• Menu Bar: Structured to provide access to all features within the Data Bridge application.
• Toolbar: Located below the menu bar, the toolbar is a customizable object allowing one-click access

to specific features via icons.
• Workspace: A list view of all SPE files existing within the currently opened CTF file. Files details listed

include the specification file name, input file, number format, output file, output method, trace, and
the SQL/MDX statement generated by Data Bridge to query the datasource, if relevant. The workspace
allows access to the Data Bridge Specification Wizard.

• "View" window: Opens when you select a specification file in the workspace. The "View" window
displays selected views of data. The following views are available via tabs at the bottom of the
screen: View SPE File, View Input Data, View Mapping Preview, and Message Window. The tabs
can be switched on or off via the View menu in the Menu Bar. The window can be docked or undocked
(that is, become a floating window) by clicking the pushpin ( ) icon. All bars and dockings can be
reset by selecting Reset Bars and Docking from the View menu.

• Status Bar: Displays the name of the User logged on, the model selected, the destination selected,
and a tooltip indicating the area of the cursor.
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Related Topics
• Data Bridge Specification File Wizard

5.2 Logging in/out of models in Data Bridge

When using Data Bridge you must always be logged into a valid model. However, if you have not logged
in and attempt to perform an action, the application will load the "Login" screen automatically.

Note:
If you are logged in to Model Builder and have the model open, you can open Data Bridge by selecting
Tools > Launch > Data Bridge. If you launch Data Bridge in this way, you do not need to log in.

Once you have logged into Data Bridge, you must either select a model to open, or create a new model
to open. You can also delete models, if you wish.

5.2.1 To login

1. Select the Login menu command or click on the icon on the toolbar.
2. You must enter a valid user name and password into the "Login" screen.
3. If you select Remember User Name, the application displays the last used User Name when the

"Login" screen is next loaded.
4. Once you have entered the user name and password, click the Model button. At this point, the

application will validate the user name and password and, if valid, load the "Select Model" dialog
box.

Note:
Passwords are case sensitive.

5. Once the model has been selected, click OK to confirm login.
6. To log out of the model, select the Logout menu command or click the icon on the toolbar. You will

then be logged out of the model and have to log back in to continue using “Data Bridge”.

Related Topics
• To select a model

5.2.2 To select a model
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A list of available models is displayed in the "Select Model" dialog box.
1. Select the required model and click OK.

The selected model appears in the in the Model box in the "Login" dialog box.

2. Select the network location of the model.
3. Choose the required model from the drop-down list, and click Open.

Note:
You will only see available models for your installed application.

5.2.3 To create a model

The "Select Model" dialog box allows you to create new models.
1. Click New.
2. In the "Create new Model" dialog box, enter a name in the Model Name box, choose a model type

from the Model Type list, and enter a description in the New Model Description box, if requried.
3. If you want to turn on auditing for the model, select Audit Model.
4. Click OK.

For more information on creating model, see the relevant chapter in the SAP BusinessObjects
Profitability and Cost Managament User Guide.

The new model name displays in the list in the "Select Model" dialog box.

5.2.4 To delete a model

1. In the "Select Model" dialog box, select the model you want to remove and click Delete.
2. In the confirmation dialog box, specify whether to delete all audit records and views for the model

and click Yes.

The model is removed from the list of available models in the "Select Model" dialog box.

5.3 Links to Datasources
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Overview
To import data from SAP Netweaver® Business Warehouse, relational databases, and other datasources
Data Bridge enables users to define links to datasources using middleware such as SAP remote Function
Call (RFC) and OLE DB (Object Linking and Embedding, Database) providers. Data Bridge uses the
links to access the datasources and generates the simple SQL (Structured Query Language) and MDX
(MultiDimensional Expressions) statements needed to query the datasources. Data Bridge retrieves
the data in a flattened form that can be handled similarly to a flat file. That is, you can create a
Specification (SPE) file that defines the structure and format for the retrieved data in the same way as
you would for a flat file. You can define links using the following providers:
• SAP Remote Function Calls (RFCs)
• ODBC (Open Database Connectivity)
• OLE DB and OLE DB for OLAP (ODBO) providers
• IBM's DB2 Call Level Interface (CLI)
• Oracle Call Interface (OCI).

SAP RFCs
RFC is an SAP application programming interface (API) that provides a means for data exchange
between a client and a server. Remote function calls can be used with SAP applications and ABAP
programming (Advanced Business Application Programming) to provide a way for external applications
to use data returned from an SAP server. For use in Data Bridge, you can define connections using
the following Remote Function Calls to connect to an SAP Netweaver® Business Warehouse datasource:
• SAP NW BI RFC (load balancing)
• SAP NW BI RFC (specific server) - this is the recommended option, as it is the simplest option and

is likely to be the most familiar to users
• SAP NW BI RFC (using saplogon.ini)
• SAP NW BI RFC (using sapnwrfc.ini)

For more information on the Netweaver RFC API, please consult the relevant documentation on the
SAP Help Portal at http://help.sap.com.

ODBC
ODBC is a standard software API (application programming interface) method for using database
management systems. It was designed to be independent of database systems and programming
languages. Depending on the datasources available on your system, you can define ODBC links to
datasources that include the following:
• dBase files
• Excel files
• Microsoft Access database tables

OLE DB and ODBO Providers
OLE DB is a standard API (application programming interface) for exchanging data between an OLAP
server and a Windows client. OLE DB providers can access relatively simple datasources such as
spreadsheets and text files, as well as complex databases such as Microsoft SQL Server and Oracle.
ODBO is an extension for OLE DB that enables the API to access multidimensional data stores and
therefore cubes using MDX. Profitability and Cost Management allows you to define links for Data
Bridge by using various providers, which can include the following:
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• Microsoft Jet 4.0 OLE DB Provider
• Microsoft OLE DB Provider for Analysis Services 9.0
• Microsoft OLE DB Provider for Data Mining Services
• Microsoft OLE DB Provider for DTS Packages
• Microsoft OLE DB Provider for Indexing Services
• Microsoft OLE DB Provider for ODBC Drivers
• Microsoft OLE DB provider for OLAP Services 8.0
• Microsoft OLE DB Provider for Oracle
• Microsoft OLE DB Provider for SQL Server
• Microsoft OLE DB Simple Provider
• MS DataShape
• OLE DB Provider for Microsoft Directory Services
• Profitability and Cost Management - the application's MDX connector
• SQL Native Client - See Note below.
• SQL Server Replication OLE DB Provider for DTS
• SQLXMLOLEDB
• SQLXMLOLEDB 4.0

Restriction:
There is a known issue with the Microsoft SQL Server Native Client 10.0 driver that if Windows
authentication is the chosen authentication mentod, any link set up fails to connect. This happens
because the link does not persist the users' password. We recommend that users use the default SQL
Server OLEDB driver instead. This has as the same result as using the Microsoft SQL Server Native
Client 10.0 driver, because the new features available in the Native Client are not utilized in Profitability
and Cost Management.

DB2 CLI
The DB2 Call Level Interface is an IBM standard for DB2 database servers and is used for establishing
connections to DB2 servers and passing dynamic SQL statements. DB2 CLI is based on the ODBC
(Open Database Connectivity) standard, so it is not tied to a specific product or environment.

OCI
The Oracle Call Interface is a set of APIs that provide interaction with an Oracle database, such as
using SQL to access and query data.

5.3.1 Creating links to datasources

To create and maintain links to datasources, Data Bridge allows you to define connections to various
datasources, and to create and run SQL and MDX queries against those datasources.

You create and edit links via the New Link and Edit Link commands in the "Data Bridge Specification
Wizard". These command access the "Create a New Link" and "Parameters" dialog boxes.
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The specific steps you take to define a link depend on the datasource you want to connect to and the
information provider you choose. Once you have accessed the "Create a new Link" dialog box, the
general procedure to create a link is as follows:
1. Choose an appropriate information provider.
2. Supply the necessary connection parameters, which can include the following:

• The name and location of the datasource
• A username and password
• The name of the database server
• A database or catalog name

3. Test the connection.
4. If required, configure advanced settings, which can include the following:

• Network settings, such as impersonation and connection levels
• Connection timeout settings
• Access permissions

5. If required, review the initialization parameters and edit them.
6. Name and save the link.

5.3.1.1 To access the "Create a new Link" dialog box

1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:
• Select Create a new Data Bridge control file and specification file using the Wizard in the

"Welcome" dialog box.
• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. On the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse ( ) button on the right-hand side of the

Specification File box.
4. In the "Select a Data Bridge Specification File" dialog box do one of the following:

• Navigate to an existing Specification file, select it, and click Open.
• Navigate to the location where you want to save a new file, enter a name for the new file in the

File name box, and click Open.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The Link ID list appears as well as the New Link button.

7. Click New Link.
The "Create a new Link" dialog box opens.

2010-01-2656

Using Data Bridge



Related Topics
• Specification Wizard – Specification File screen

5.3.1.2 Creating a link to an SAP Netweaver BW datasource

To connect to anSAP Netweaver® Business Warehouse (SAP Netweaver BW) datasource, such as a
query cube (an SAP dataset), you need to define a link using the SAP Remote Function Call (RFC).
The RFC supports connections through the following:
• Load balancing - the application server to which you connect is determined at runtime
• A specific server - this is the simplest option and the one with which most SAP users are familiar
• An INI file - you can create INI files for both the load balancing or specific server options.

Note:
If you have any of the above connections set up in the SAP Logon pad, the values for the connection
parameters you must supply are the same as those set in the SAP Logon pad. If you need further help
finding which settings to enter, please contact your SAP system administrator or IT Support department.

Creating a link using load balancing
If you choose the SAP NW BI RFC (load balancing) option when defining a connection to an SAP
Netweaver® BW datasource, you need to provide the following parameters:
• A name or ID for the link and a description
• The name of the SAP system - for example Q75. This is an optional setting.
• The host name of the message server - for example usciq.wdf.sap.corp
• The group name of the application servers - for example, PUBLIC. This is an optional setting; the

default value is PUBLIC.
• Your SAP Netweaver® BW user ID and password
• You language choice - English (EN) or German (DE), for example
• The client ID - for example 003
• The RFC trace - the values are 0 = OFF or 1 = ON (0 is the default)
• MySapSS02 - use when logging on with a “Single Sign On” (SSO) ticket
• X509Cert
• The partner SNC (Secure Networks Communication) name - this is an optional setting. Use when

logging on with SNC.
• Your SNC name - this is an optional setting. Use when logging on with SNC.
• The SNC library path - this is an optional setting. Use when logging on with SNC.
• SNC_QOP - the security level, for example 0. Use when logging on with SNC.
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Creating a link to a specific server
We recommend that you choose the SAP NW BI RFC (specific server) option when defining a link to
an SAP Netweaver® BW datasource. This is the simplest option and the one with which most users
are familiar. Provide the following connection parameters:
• A name or ID for the link and a description
• The name of the SAP system - for example Q75. This is an optional setting.
• The host name of a specific SAP application server - for example usciq75.wdf.sap.corp
• The SAP system number - for example 10
• The gateway host - this is an optional setting. The default is the gateway on the application server.
• The gateway server - this is an optional setting. The default is the gateway on the application server.
• Your SAP Netweaver® BW user ID and password
• You language choice - English (EN) or German (DE), for example
• The client ID - for example 003
• The RFC trace - 0 = OFF or 1 = ON (0 is the default)
• MySapSS02 - use when logging on with an SSO ticket
• X509Cert
• The partner SNC (Secure Networks Communication) name - this is an optional setting. Use when

logging on with SNC.
• Your SNC name - this is an optional setting. Use when logging on with SNC.
• The SNC library path - this is an optional setting. Use when logging on with SNC.
• SNC_QOP - the security level, for example 0. Use when logging on with SNC.

Creating a link using an INI file
You can define a link that uses an INI file called either sapnwrfc.ini or saplogin.ini, in which you enter
all the required connection parameters. The INI file must be in the current directory (the PAS home
directory).

The INI file for a link that uses load balancing contains the following parameters:

DEST = <destination in RfcOpenConnection>
R3NAME = <name of the SAP system, optional; default: destination>
MSHOST = <host name of the message server>
MSSERV = <host name of the message server>
GROUP = <group name of the application servers, optional; default: PUBLIC>
RFC_TRACE = <0/1: OFF/ON, optional; default: 0(OFF)>

The INI file for a link to a specific server contains the following parameters:

DEST = <destination in RfcOpenConnection>
ASHOST = <hostname of a specific SAP application server>
SYSNR = <SAP System Number>
GWHOST = <option; default: gateway on application server>
GWSERV = <optional; default: gateway on application server>
RFC_TRACE = <0/1: OFF/ON, optional; default: 0(OFF)>

When you are creating the link for Data Bridge and you choose the provider option SAP NW BI RFC
(saplogon.ini) or SAP NW BI RFC (sapnwrfc.ini), you need only enter the following connection
parameters:
• A name or ID for the link and a description

2010-01-2658

Using Data Bridge



• The destination parameter in RFCOpenConnection, the function that opens a client connection to an
SAP system. This is the same destination that you entered in the INI file, for example OLAPSERVER.

• Your SAP Netweaver® BW user ID and password
• You language choice - English (EN) or German (DE), for example
• The client ID - for example 003

Note:
The RFC connector used by Profitability and Cost Management uses standard OBDO BAPIs (Business
Application Programming Interfaces) by default. The OBDO BAPIs are limited to one million cells fetched
per query. The newer SAP RSR BAPIs are unlimited in terms of the number of cells per fetch. You can
configure the connector to use the RSR BAPIs by setting the Library parameter to RSR. For more
information, see SAP Note 1232751.

For more information on RfcOpenConnection, please see the relevent documentation on the SAP Help
Portal at http://help.sap.com

5.3.1.2.1 To create a link to an SAP Netweaver BW datasource
1. Open the "Create a new Link" dialog box.
2. In the "Available data sources" box, select one of the following options and click OK:

• SAP NW BI RFC (load balancing)
• SAP NW BI RFC (specific server)
• SAP NW BI RFC (using saplogon.ini)
• SAP NW BI RFC (using sapnwrfc.ini)

3. In the "Parameters" dialog box, enter the required parameters.
At this point, you can click Test to verify that you have entered the correct parameters.

4. Click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard".

Related Topics
• To access the Create a new Link dialog box

5.3.1.3 Creating a link to an ODBC datasource

To import data from ODBC (Open Database Connectivity) sources such as Microsoft Excel spreadsheets
or Microsoft Access databases, you need to define a link by selecting the appropriate ODBC provider,
and providing connection parameters, such as the database name or the location of the datasource.

Before you can create a link, the ODBC datasource must exist as a System DSN (Data Source Name)
on the machine. The DSN is required in the setup of ODBC to specify connection information for a
database server. If you experience problems creating links to ODBC datasources, you may need to
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first add the datasource as a System DSN in the Windows "ODBC Data Source Administrator". When
you add the datasource, specify that it is read-only.

Once you have added the datasource as a System DNS, the datasource is listed as one of the available
datasources in the "Create a new Link" dialog box. You use that datasource to create the link.

5.3.1.3.1 To add a datasource as a System DSN

When creating links to ODBC (Open Database Connectivity) datasources, you can experience problems
depending on the version of the software that created the datasources. For example, it can appear that
you created a link to a datasource successfully, but you are unable to view or access tables in the
datasource, or you receive an error message when you use the link in the "Data Bridge Specification
Wizard". In such cases, adding the datasource as a System DSN in Windows "ODBC Data Source
Administrator" can resolve the problem.
1. In the Windows "Control Panel", access "Administrative Tools" and open "Data Sources (ODBC)".

2. In the "ODBC Data Source Administrator" dialog box, click the System DSN tab.
3. Click Add.
4. In the "Create New Data Source" screen, select the driver for which you want to set up the datasource.

For example, for a Excel 2003 spreadsheet, select Microsoft Excel Driver (*.xls).

Restriction:
ODBC drivers for Excel and Access are currently not available for all supported 64-bit environments.

5. Click Finish.
6. In the "Setup" dialog box, enter a name in the Data Source Name box and select the datasource.

For example:
• For an Excel datasource, select the version in the Version list, click Select Workbook, and navigate

to the workbook that contains the data you want.
• For an Access database, click Select and navigate to the database that you want.

7. Click Options and select Read Only.
8. Click OK.

The datasource is listed in the System DSN tab and is available as a provider in the "Create a new
Link" dialog box.

5.3.1.3.2 Example: To create a link to a Microsoft Access database
1. Open the "Create a new link" dialog box.
2. In the "Available data sources" box, select (ODBC) MS Access Database and click Open.
3. In the "Select Database" dialog box, navigate in the "Directories" pane to the location of the database

that you want to use as a datasource.
You can select which drives to display in the "Directories" pane in the Drives list.
The "Database Name" pane lists all databases in the selected location. You can select which files
types to display in the pane using the List Files of Type list.

4. Select the database that you want as a datasource and click OK.
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The "Parameters" dialog box displays the values for the connection parameters DBQ, DefaultDir,
DriverID, FIL, MaxBufferSize, and PageTimeout.

5. Enter an ID for the link in the LinkID box and click Test to verify that the connection parameters are
correct.

6. Click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard". The worksheets
in the workbook can be viewed and treated as database tables in the wizard.

Related Topics
• To access the Create a new Link dialog box

5.3.1.3.3 Example: To create a link to a Microsoft Excel workbook

To access data in Microsoft Excel spreadsheets, you create a link to the Excel workbook that contains
the worksheets you require.
1. Open the "Create a new link" dialog box.
2. In the "Available data sources" box, select (ODBC) Excel Files and click Open.
3. In the "Select Workbook" dialog box, navigate in the "Directories" pane to the location of the workbook

that you want to use as a datasource.
You can select which drives to display in the "Directories" pane in the Drives list.
The "Database Name" pane lists all workbooks in the selected location. You can select which files
types to display in the pane using the List Files of Type list.

4. Select the workbook that you want as a datasource and click OK.
The "Parameters" dialog box displays the values for the connection parameters DBQ, DefaultDir,
DriverID, FIL, MaxBufferSize, and PageTimeout.

5. Enter an ID for the link in the LinkID box and click Test to verify that the connection parameters are
correct.

6. Click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard". The worksheets
in the workbook can be viewed and treated as database tables in the wizard.

5.3.1.4 Creating a link to a relational database

You may want to import database tables from one Profitability and Cost Management model into another
or you may want to import data from another relational database source. To create a link to a database
datasource, you need to choose an appropriate information provider and supply connection parameters
such as the database server, database name and location, and a username and password.
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Note:
If you choose to use a specific username and password to connect to a database you MUST also
choose the option to Allow saving password. Otherwise, the password entry is not saved in the
parameters list. This means that it cannot be passed to the datasource and the connection fails.

5.3.1.4.1 To create a link to a relational database

Follow these steps to create a link to a database by using an OLE DB (Object Linking and Embedding,
Database) provider.
1. Open the "Create a new Link" dialog box.
2. In the "Available data sources" box, select (OLEDB) Providers and click Open.
3. In the Provider tab of the "Data Link Properties" dialog box, select an appropriate provider and click

Next.
4. Complete the settings in the Connection tab by supplying the required information such as the

database name, database server, and database login credentials.

Note:
If you choose the option to use a specific user name and password to log on to the database server
you MUST also select the Allow saving password check box.

5. Click Test Connection to test the connection and verify that you have entered the correct information.
6. If required, click the Advanced tab and adjust the network settings, connection timeout settings, and

access permissions.
7. If required, click the All tab to view the list of initialization parameters for the datasource. To edit a

value, select a parameter and click Edit Value. In the "Edit Property Value" dialog box, enter a new
value in the Property Value box and click OK.

8. In the "Data Link Properties" dialog box, click OK.
9. In the "Parameters" dialog box, enter a name in the Link ID box.

You can also click Test to test the link or you can edit the information in the boxes in the dialog box.

10. Click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard".

Related Topics
• To access the Create a new Link dialog box

Example: To create a link to a database using Microsoft OLE DB Provider for SQL Server

To create a link to a database by using the information provider Microsoft OLE DB Provider for SQL
Server, proceed as follows:
1. Open the "Create a New Link" dialog box.
2. In the "Available data sources" box, select (OLEDB) Providers and click Open.
3. On the Provider tab of the "Data Link Properties" dialog box, select Microsoft OLE DB Provider for

SQL Server and click Next.
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4. In the Connection tab, select the database server from the Select or enter a server name list.
Click Refresh to refresh the list.

5. To enter information to log on to the server, do one of the following:
• Select Use Windows NT Integrated security.
• Select Use a specific user name and password and enter the login credentials in the User name

and Password boxes. Select Allow saving password.

Note:
If you have Single Sign On (SSO) configured, these settings are overriden and SSO is used.

6. To specify the database you want to connect to, do one of the following:
• Select the Select the database on the server option and select the database from the list.
• Select the Attach a database file as a database name option and enter a filename or use the

Browse ( ) button to access the "Select SQL Server Database file" dialog box, navigate to
the file you want, select it, and click Open.

7. Click Test Connection to verify you have entered the correct information.
8. Click OK.
9. In the "Parameters" dialog box, enter a name for the link in the Link ID box and click OK.

The link is created and is available for use in the "Data Bridge Specification Wizard".

Related Topics
• To access the Create a new Link dialog box

5.3.1.5 Creating a link to an OLAP cube

In addition to defining links to cube data from SAP Netweaver Business Intelligence Warehouse, you
can define links to other OLAP cubes, such as other Profitability and Cost Management models.

To create a link to an OLAP cube datasource, you need to choose an appropriate information provider,
and supply connection parameters such as the datasource name and location, a username and password,
and the name of the catalog.

5.3.1.5.1 To create a link to an OLAP cube

Follow these steps to create a link to an OLAP cube datasource by using an OLE DB (Object Linking
and Embedding, Database) provider.
1. Access the "Create a new Link" dialog box
2. In the "Available data sources" box, select (OLEDB) Providers and click Open.
3. In the Provider tab of the "Data Link Properties" dialog box, select an appropriate provider and click

Next.
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4. Complete the settings in the Connection tab by supplying the required information such as the data
source and location, the login credentials, and the initial catalog to use.

5. Click Test Connection to test the connection and verify that you have entered the correct information.
6. If required, click the Advanced tab and adjust the network settings, connection timeout settings, and

access permissions.
7. If required, click the All tab to view the list of initialization parameters for the datasource. To edit a

value, select a parameter and click Edit Value. In the "Edit Property Value" dialog box, enter a new
value in the Property Value box and click OK.

8. In the "Data Link Properties" dialog box, click OK.
9. In the "Parameters" dialog box, enter a name in the Link ID box.

You can also click Test to test the link or you can edit the information in the boxes in the dialog box.

10. Click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard".

Related Topics
• To access the Create a new Link dialog box

Example: To create a link to a Profitability and Cost Management model using the MDX Connector

Profitability and Cost Management models are OLAP (Online Analytical Processing) cubes. To use
Data Bridge to import structures and values from one Profitability and Cost Management model to
another, create a link to the model catalog using the SAP BusinessObjects Profitability and Cost
Management MDX Connector. Proceed as follows:
1. Open the "Create a new Link" dialog box.
2. In the "Available data sources" box, select (OLEDB) Providers and click Open.
3. In the Provider tab of the "Data Link Properties" dialog box, select Profitability and Cost Management

and click Next.
4. In the Connection tab, to enter log in credentials to connect to the datasource, do one of the following:

• Select Use Windows NT Integrated security.
• Select Use a specific user name and password and enter the correct Profitability and Cost

Management login credentials in the User name and Password boxes. If required, select the
checkboxes Blank password or Allow saving password.

Note:
If you have “Single Sign On” (SSO) configured, these settings are overridden and SSO is used.

5. Select the catalog you want to connect to in the Enter an initial catalog to use list.
Depending on the security option you configured in step 4, the "MDX Connector" dialog box appears
when you click the list. Enter the correct Profitability and Cost Management login credentials and
click OK to populate the list with the available catalogs.

6. Click Test Connection to verify that you have entered the correct information.
7. Click OK.

The "Parameters" dialog box lists all the connection parameters.
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8. Enter a name for the link in the Link ID box and click OK.

The new link is created and is available for use in the "Data Bridge Specification Wizard".

Note:
The example above assumes that the Profitability and Cost Management client in which you configure
the link is installed locally on the Application Server. If you want to configure a link using the MDX
Connector to a catalog on a BusinessObjects Enterprise server and the client in which you configure
the link is not installed locally on the BusinessObjects Enterprise server, you must specify the location
of server (the Central Management Server or CMS) against which you want to authenticate. To do this,
enter the server name in the Location text box in the "Data Link Properties" dialog box.

Related Topics
• To access the Create a new Link dialog box

5.4 Data Bridge Specification File Wizard

The Data Bridge Specification File Wizard is designed to guide the user through the steps needed to
successfully create Specification and Control files. This wizard consists of a number of dialog boxes
that enable you to set up all the required data for the control file record.

Whereas the Specification Files created using the Wizard are sufficient for performing basic
functions—allowing the User to import data in a simple manner—Specification File Statements used
to perform more complex functions can be added using the "Specification File Editor".

Caution:
Specification Files that have complex functionality should NOT be edited using the Wizard, because
this will remove the additional statements.

5.4.1 Data Bridge Specification Wizard Workflows

The path that you take through the screens of the "Data Bridge Specification Wizard" depends on the
datasource from which you import data. The diagrams and sections that follow outline the workflows
for the different types of data import.

Overview
For each type of datasource, you navigate through the "Welcome" screen of the wizard and either select
or create a Specification (SPE) file in the "Specification File" screen. In the "Select Datasource" screen,
you select a datasource and then perform tasks specific to that type of datasource. The types of
datasource are as follows:
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• A flat file (a text file)
• SAP Netweaver® Business Warehouse data
• Structural data from an OLAP cube
• Values data from an OLAP cube
• A relational database table

Note:
To import data from SAP Netweaver® Business Warehouse, follow the workflows to import either
structural or values data from an OLAP cube.

When you complete the datasource-specific tasks, you work through the "Specification Wizard" screens
that are common to all datasources. In order, the common screens are as follows:
• "Field Mappings" screen
• "Lookup Fields" screen
• "Ignore Records" screen
• "Select Records" screen
• "Ignore Characters" screen
• "Generated SPE File" screen
• "Run Options" screen

When you complete these screens, for all datasources you then create, validate, and run the Control
(CTF) file and the data is imported into your model. The diagram that follows illustrates this overview of
using the "Data Bridge Specification File Wizard":
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5.4.1.1 Workflow for a flat file

When you select a flat file as the datasource in the "Data Bridge Specification Wizard", you complete
tasks specific to that type of datasource. After selecting the file, you proceed as follows:
1. Specify whether to run the specification wizard in the "Configure Specification" file screen.
2. Choose the table to import the data to in the "Table Setup" screen
3. In the "Choose Representative Data" screen, select a line of data from the text file to be used to in

subsequent screens to set up field definitions.
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4. In the "Field Setup" screen, select a delimiter to separate the respresentative data into different
records.

After completing these steps, you work through the common screens in the wizard, and then create,
validate, and run the CTF file to import the data. The diagram that follows illustrates the workflow outlined
here:

5.4.1.2 Workflow for an SAP Netweaver® Business Warehouse datasource

When you import data from SAP Netweaver® Business Warehouse into a model, you are connecting
to a query cube - an OLAP cube. You therefore follow the workflow to import either structural data or
values data from an OLAP cube, as outlined in the following diagram:
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Related Topics
• Workflow for importing values from an OLAP cube
• Workflow for importing structure from an OLAP cube

5.4.1.2.1 Workflow for importing structure from an OLAP cube

When you select structures in an OLAP cube - such as an SAP Netweaver BW query cube - as the
datasource in the "Data Bridge Specification Wizard", you complete tasks specific to that type of
datasource. After selecting a link to the datasource and specifying that you want to both import a
structure and run the wizard to select the structure, you proceed as follows:
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1. In the "Import OLAP Structure" screen, select a dimension hierarchy to import.
2. Specify whether to run the specification wizard in the "Configure Specification" file screen.
3. Choose the table to import the data to in the "Table Setup" screen.

Note:
When you are importing structural data into a model, choose the PARENTCHILD or PARENTCHILD_BULK

table. PARENTCHILD is the default option available in the screen you when you are importing
structural data from an OLAP cube.

After completing these steps, you work through the common screens in the wizard, and then create,
validate, and run the CTF file to import the data.

5.4.1.2.2 Workflow for importing values from an OLAP cube

When you select values in an OLAP cube - such as an SAP Netweaver BW query cube - as the
datasource in the "Data Bridge Specification Wizard", you complete tasks specific to that type of
datasource. After selecting a link to the datasource and specifying that you want to both import values
and run the MDX Generation Wizard, you proceed as follows:
1. In the first screen of the "MDX Wizard" screen, select a catalog, cube, and a measure. Specify

whether to filter values.
2. In the second screen of the "MDX Wizard" screen, choose the appropriate dimension hierarchy

items so as to build a flattened cube of values.
3. Preview the MDX statement automatically generated by the wizard in the "Preview SQL or MDX

Statement" screen, which also displays the first 50 records of the query.
4. Specify whether to run the specification wizard in the "Configure Specification" file screen.
5. Choose the table to import the data to in the "Table Setup" screen.

After completing these steps, you work through the common screens in the wizard, and then create,
validate, and run the CTF file to import the data.

5.4.1.3 Workflow for a relational database table

When you select a relational database table as the datasource in the "Data Bridge Specification Wizard",
you complete tasks specific to that type of datasource. After selecting a link to the datasource, you
proceed as follows:
1. In the "Relational Database Options" screen, select a table or view to import and specify which fields

to import.
2. Preview the SQL statement automatically generated by the wizard in the "Preview SQL or MDX

Statement" screen, which also displays the first 50 records of the query.
3. Specify whether to run the specification wizard in the "Configure Specification file" screen.
4. Choose the table to import the data to in the "Table Setup" screen
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After completing these steps, you work through the common screens in the wizard, and then create,
validate, and run the CTF file to import the data.

Note:
When you use a Microsoft Excel workbook as a datasource, you follow this workflow.

The diagram that follows illustrates the workflow outlined here:

5.4.2 Data Bridge Specification Wizard Screens

5.4.2.1 Specification Wizard – Welcome Screen

The "Welcome" screen in the first screen in the wizard and is activated by selecting the Insert item from
the menu or by pressing the Insert key.

The wizard interface is based on the Microsoft standard, and navigation is directed by clicking either
the Next or Back buttons to move in the desired direction. The Cancel button allows the wizard to be
closed.

Click Next.
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5.4.2.2 Specification Wizard – Specification File screen

The "Specification File" screen allows you to select the name and location of the Specification File. You
can create a new file or load an existing one.

Click the Browse button on the right-hand side of the Specification File box to open the "Select a
Data Bridge Specification File" dialog box.

In this dialog box, you can navigate to the directory where the Specification file is to be stored and select
an existing file or create a new one. This is a standard Windows dialog box. If you load an existing file,
the details are displayed in the scrollable panel in the dialog.

You can also select and create Specification files on Networks via mapped drives, allowing you to share
these files with other people within your organization.

Click Next to continue,

5.4.2.3 Specification Wizard – Select Datasource screen

The "Select Datasource" screen allows you to specify the file or datasource to import. Select one of the
following:
• Import from flat file to import a text file
• Import from external datasource to import from a relational database or an OLAP cube.

If you selected Import from flat file, click the Browse button to the right of the Input File box to open
the "Select an input file" dialog box.

When you load the data file you can view the information by clicking the View button . This opens
the data file in Microsoft Notepad.

If you selected Import from an external datasource, select an appropriate link in the Link ID list, which
lists all the links you have created in Data Bridge. If an appropriate link is not available, click New Link
to access the "Create a new Link" dialog box.

When you select a link, the Edit Link and Delete Link buttons become active.

When you select a link to an OLAP cube datasource, you must specify whether to Import Structure or
Import Values. If you select Import Structure, the Run Wizard to select which structure to import check
box is selected by default.

If you select Import Values, the Run MDX Generation Wizard check box is selected by default.

Once you select a datasource, click Next to continue.
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Related Topics
• Running the Control File
• Creating links to datasources

5.4.2.4 Specification Wizard - Relational Database Options

If you choose to import from a relational database, you are presented with the "Relational Database
Options" screen.
1. In the list, select the table or view from which to import data.
2. In the "Select which fields to import" box, indicate which fields to import by selecting or clearing the

check boxes adjacent to each field.
3. Click Next to continue.

5.4.2.5 Specification Wizard - Preview SQL or MDX Statement

When you select a relational database or an OLAP cube as a datasource, the "Preview SQL or MDX
Statement" screen displays in the topmost display pane the SQL or MDX statement that Data Bridge
generates to query the datasource.

You can edit the statement in the display pane if you wish.

The lower display pane contains the following two tabs:
• The Grid tab displays the first 50 records of a query in a grid format.
• The Messages tab displays any relevant messages, for example how many rows are affected by

the query.

From left to right, the message bar at the bottom of the screen displays the link ID, the number of the
record currently selected in the Grid tab, and the time taken to execute the query.

Once you have previewed the statement, click Next to continue.

5.4.2.6 Specification Wizard - Import OLAP Structure

If you choose to import structures from an OLAP cube, you select the dimension heirarchy you want to
import in the "Import OLAP Structure" screen
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The screen contains a navigation tree of link IDs and the catalogs to which they connect. Each catalog
contains cubes, each of which contains a tree consisting of dimensions and the hierarchies within those
dimensions.

To make it easier understand what OLAP data is being displayed, and to locate and navigate hierarchies,
you can choose how member names and member captions are displayed in the screen.

Right-click anywhere in the screen, select ODBO Display Options from the context menu, and select
one of the following options:
• Member Caption Only
• Member Name Only
• Member Caption (Member Name)
• Member Name (Member Caption)

For example, suppose the datasource you are querying uses long unique ID numbers as member
names with easily understandable human language names as member captions. The member captions,
however, are not unique. In this case, displaying member names only is impractical, because it is difficult
to read, recall, and identify large numbers of long IDs. However, displaying only the member captions
can lead to errors, because the member captions are not unique. Displaying a combination or member
names and member captions ensures that you locate the correct structures more easily and quickly.

To select a structure to import, expand Cubes, and then expand the cube from which you want to import.
Expand Dimensions, expand the dimension that contains the hierarchy you want to import, and expand
Heirarchies. Continue navigating in the Hierarchies tree until you locate the heirarchy you want to import
and select it. Selecting a parent item automatically includes all child items and their child items.

To remove a selection, right-click anywhere in the pane and select Clear selection in the context menu.

When you have selected the structure, click Next to continue.

5.4.2.7 Specification Wizard - MDX Wizard (1)

If you choose to import values data from an OLAP cube and choose to run the "MDX Generation Wizard",
the first screen of the "MDX Wizard" is where you select the measure to import.
1. Select a catalog in the Select a catalog list
2. Select a cube in the Select a cube list.
3. Select a measure in the Select a measure list.
4. To filter for values, select the Filter Values check box and enter a filter in the accompanying box -

for example > 500 or <>0.
5. Click Next to continue.
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5.4.2.8 Specification Wizard - MDX Wizard (2)

When you import values data from an OLAP cube, you first select the measure to import in the "MDX
Generation Wizard". In the second screen of the "MDX Wizard", you choose the appropriate dimension
items to build a flattened cube of values.

For example, if you import the measure LineItemValues into model, you select appropriate members
of the key dimensions Versions, Periods, Responsibility Centers, and Line Items to import the values
you require.

To select a dimension, proceed as follows:
1. Choose an appropriate selection method from one of the following options:

• Select individual items
• Select All Descendant leaf items - this option selects only the leaf-level or bottommost items in

a hierarchy
• Select All Descendant items - this options selects all children and subchildren in a hierarchy.

2. In the Dimensions pane on the right, select a dimension.
3. In the navigation tree on the left, expand the Hierarchies node for the selected dimension, navigate

to the required dimension member or hierarchy, and select it.

When you complete this screen, you can click Next to preview the generated MDX statement in the
"Preview SQL or MDX statement" screen.

5.4.2.9 Specification Wizard – Configure Specification File

The "Configure Specification File" screen gives you the option to generate the Specification file. If you
are using an existing Specification file and do not wish to regenerate the settings, you should clear the
Run the specification wizard check box. Then, when you click Next, you will be taken to the final "Run
Options" screen.

Note:
If you choose to run the specification wizard you will automatically overwrite any settings previously
set.

Related Topics
• Specification Wizard – Run Options
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5.4.2.10 Specification Wizard – Table Setup

The "Table Setup" screen allows you to select which Table the data will be transferred into.
1. Select the Table to be imported from the Table list at the top of the screen.

Note:
If you are importing structural data, choose the PARENTCHILD table. For certain datasources, this table
appears as the default option.

2. Select the Import Method from the options in the "Import Method" area.

The following table indicates how the different Import Method options treat the new data and the
existing data, and insert load method parameters on the table header record:

Load methodOption

Overwrite and append

REPLACEReplace existing data

REPLACE SUMReplace existing data and summarize new data

SUMSummarize new data and existing data

These options take effect when Data Bridge is run.

Note:
When the PARENTCHILD table is selected, Overwrite and append is the only import method available.

3. If you are importing a flat file, in the Format area, select the format option of the file type:
• Fixed format file: a Column-based report
• Delimited file: a comma separated file

4. Click Next.

Related Topics
• Import Methods
• SAP BusinessObjects Profitability and Cost Management Tables

5.4.2.11 Specification Wizard – Choose Representative Data
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The "Choose Representative Data" screen displays the first line of the input file in the Representative
Data list and uses the previously defined delimiter to display the records.

Data Bridge will read the first 100 lines from the input file, and display them in the drop-down list. You
should select the first line of your data that you wish to be used during the import process.

Note:
You should select a line that is representative of the data stored in the source file.

Click Next.

5.4.2.12 Specification Wizard – Field Setup

If you selected Delimited File as the Format in the "Table Setup" screen, the "Field Setup" screen
appears. The screen displays the field contents when the current Delimiter is used to split up the selected
line of the source file. The delimiter defaults to a comma, but you can override this selection using the
Delimiter list at the top of the screen.

If you selected Fixed Format File as the Format in the "Table Setup" screen, the "Fixed Field Setup"
screen appears. The dialog box displays the field contents when the selected line of the source file is
split up. The field content details are listed in "Field No", "Value", "Characters From", and "Characters
To" columns in the display pane.

Data Bridge initially starts a new field when the next nonspace is found; the contents of the selected
field are displayed as separate field numbers. The "Value" Field is defined by the start and finish
characters of that value. To adjust a value, change the Character value to the desired number using
the spin box that displays when you click a Character field. New fields can be added, or redundant
fields removed using the Add and Remove buttons.

Click Next to continue.

5.4.2.13 Specification Wizard – Field Mappings

The "Field Mappings" screen displays a list of the fields in the selected table. Text at the top of the
screen gives the name of the table into which you are importing data, as well as details about the
datasource, such as the Link ID and whether the query is a schema query, an MDX query, or a query
against a relational database, for example.

The field details are listed in the columns "Field Name", "Field Type", "Column Index", and "Mapping"
in the display pane. There are two separate field types—Key field and Numeric field. Where each Field
Name is of type Key, you MUST set a mapping - that is, you map a field in the model table to a field in
the imported data. You can change the mappings using the list box that appears when you click the
Mapping field or by typing a constant value that is be used in the final input file. Fields that can be
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mapped to dimensions - for example the DimensionName field - have the dimension names listed in
their list box.

When you import flat file data, the options available in the mapping list include those fields that you
defined in the Field Setup screen and Default.

When you import a relational database table, the options available in the mapping list include the table
fields that you selected in the Relational Database Options screen and Default.

When mapping to OLAP (Online Analytical Processing) data, the mapping list can include the following
options:
• PARENT_NAME
• PARENT_CAPTION
• MEMBER_NAME
• MEMBER_CAPTION
• MEMBER_NAME_CAPTION - displays as the member name followed by an underscore (_) followed

by the member caption, for example 012345678_Sales.
• MEMBER_CAPTION_NAME - displays as the member caption followed by an underscore (_) followed

by the member name, for example Sales_012345678.

When you set the mapping for the "AttributeFlag" field, choose the ATTRIBUTE_FLAG option in the
mapping list. You can also enter or select one of the following constants:
• 10 - Main Hierarchy
• 15 - Attribute Hierarchy only
• 12 - Attribute Assignment

When you set the mapping for the ConsolidationType field, choose the CONSOLIDATIONTYPE option
in the mapping list. You can also enter or select one of the following options:
• + (Add)
• - (Subtract)
• OR (All - Attributes)
• AND (Common - Attributes)
• ~ (Don't Consolidate)

Click Preview to view a table of the data that will be imported now that you have set the field mappings.
Click OK to close the "Preview" window.

Click Next to continue.

Related Topics
• The ParentChild Table
• SAP BusinessObjects Profitability and Cost Management Tables
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5.4.2.14 Specification Wizard – Lookup Fields

The "Lookup Fields" screen allows you to specify a field name in the source data, together with a
filename that contains a replacement for the original name. This allows names in the source file to be
matched against those in the database.

For each field name, you need to add a separate statement line.
1. Click Add to add a new statement line.

The "Lookup Fields" dialog box will open.

2. In the Field to lookup and replace list, select the field name in the source file.
3. Click Browse to locate the “lookup” file containing the replacement field name, and then click Open

when you have selected it.
The "File to perform lookup against" box, will now contain the name of the selected file.

4. If you wish to match the field name in the source with the name in the “lookup” file irrespective of
case, select the Ignore case checkbox.

5. Click OK.
The statement line will be displayed in the columns "Field Name", "File Name", and "Ignore case".

6. Use the buttons Add to add more statement lines, Edit to amend lines that you have created and
Remove to delete any that are not required.

7. Click Next to continue.

5.4.2.15 Specification Wizard – Ignore Records

The "Ignore Records" screen gives the option to ignore records that contain a particular string, are at
a particular position within a line, or are of a particular value.

Data is entered directly into the screen in the appropriate field in the "Ignore lines containing string" or
"Ignore records of a certain value" areas. Additional criteria can be entered or removed by clicking the
Add or Remove buttons for each area. The Edit button is only available when a line containing data is
selected, and allows the criteria to be amended for that record.

Click Next to continue.

5.4.2.16 Specification Wizard – Select Records
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Whereas the "Ignore Records" screen allows data to be selectively ignored, the "Select Records" screen
allows data selection based on the string entered. All data without this string will be ignored.

Data is entered directly into the screen in the Select String field. Additional criteria can be entered or
removed by pressing the Add or Remove buttons. The Edit button is only available when a line containing
data is selected, and allows the criteria to be amended for that record.

Click Next to continue.

5.4.2.17 Specification Wizard – Ignore Characters

The "Ignore Characters" screen gives the option of being able to ignore particular characters from the
input file, for example double quotation marks (").

Data is entered directly into the screen in the Ignore character and Ignore if in line at position (Blank is
anywhere) fields. Additional criteria can be entered or removed by pressing the Add or Remove buttons.
The Edit button is only available when a line containing data is selected, and allows the criteria to be
amended for that record.

Click Next to continue.

5.4.2.18 Specification Wizard – Generated SPE file

This dialog box allows you to preview the Specification file that has been generated by the wizard. The
display window is editable and you can change any settings that have been made by the wizard. The
dialog box has its own Properties menu and can be configured using the context menu.

You can also click Show input file to display the contents of the input file that displays on the right-hand
side of the screen.

Click Next to continue.

5.4.2.19 Specification Wizard – Run Options

The "Run Options" screen is the last input screen in the wizard. The options displayed are:
• The Trace On check box – Each Control record has a separate Trace flag, and the current Control

record’s flag can be selected / deselected using the Trace option. This allows you to track any errors
when running the specification files.

2010-01-2680

Using Data Bridge



• The European Number Format check box – This option will convert numbers from the UK format to
the format used in other European countries, such as France, where the decimal point is a comma
(2.75 becomes 2,75).

• The Convert Tabs check box – This allows you to set a character (such as comma or space) to
replace any tabs in the input file. You type the character in the Convert to box.

Click Next to continue.

Related Topics
• Running the Control File
• Specification Wizard – Select Datasource screen

5.4.2.20 Specification Wizard – Completion

In the final screen of the wizard, click Finish to close the wizard and save all changes made to the
Specification file.

5.4.3 Running the Data Bridge Specification File Wizard

5.4.3.1 Example: To create a SPE file to import a flat file

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import a CSV (Comma Separated Values) file of Activity Driver values (ADVS.csv) exported from one
Profitability and Cost Management model into another Profitability and Cost Management model. The
import overwrites any original data and adds new data. In this example, no lookup fields settings are
configured, no records or characters are ignored, and no records are specifically selected based on
text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
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3. In the "Specification File" screen, click the Browse button ( ) to the right of the Specification File
box.

4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want
to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen ensure that Import from a flat file is selected and click the Browse

( ) button to the right on the Input Data box.
7. In the "Select an input file" dialog box, navigate to the file to import - ADVS.csv, in this case - select

the file and click Open.
The Input Data box displays the filepath of the selected file.

8. Click Next.
9. In the Configure Specification File screen, ensure the Run the specification wizard check box is

selected and click Next.
10. In the "Table Setup" screen, select ACTIVITYDRIVERVALUE in the Table list.
11. In the "Import Method" area, ensure Overwrite and append is selected.
12. In the "Format" area, ensure Delimited file is selected and click Next.

The "Choose Representative Data" screen displays the first line of text in the file in the Representative
Data list. This line is representative of the fields you want to import.

13. Click Next.
14. In the "Field Setup" screen, ensure that a comma is select in the Delimiter list and click Next.
15. In the "Field Mappings" screen, ensure that the key field, "ActivityDriverName", is mapped to the

field that contains the Activity Driver name in the input file. If it is not, click in the Mapping list for that
field and select the correct field in the list.

16. If required, repeat the process in step 15 until the fields in the input file and mapped correctly to the
fields in the ACTIVITYDRIVERVALUE table.
Use the Preview button to check whether you have mapped the fields correctly.

17. Click Next.
18. In the "Lookup Fields" screen, click Next.
19. In the "Ignore Records" screen, click Next.
20. In the "Select Records" screen, click Next.
21. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

22. In the Run Options screen, click Next.
23. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.
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Example:

The generated SPE file is as follows:

//Table Destination
TABLE ACTIVITYDRIVERVALUE
//Fields to be loaded from source file
ACROSS ActivityDriverName, CostObject1Name, CostObject2Name, ActivityDriverValue
//Set delimiter.
TREAT ',' Delimiter
//Data is delimited.
RECORD Control
DATA(A*)
DATA(A*)
DATA(A*)
DATA(N*)

SKIP TO EOL
END ON EOF

Related Topics
• Workflow for a flat file

5.4.3.2 Example: To create a SPE file to import structural data from SAP
Netweaver® Business Warehouse

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import multi-level structural data from SAP Netweaver Business Warehouse (SAP Netweaver BW)
into a Profitability and Cost Management model to build a Responsibility Center dimension.

These steps assume the following:
• You have created a query cube in SAP Business Explorer (SAP BEx)
• Your query has 0COSTCENTER in either rows or free characteristics
• You have a hierarchy defined for 0COSTCENTER in BW Master Data

Remember:
Ensure that you release the query for External Access. Go to BEx Query Properties and open the
Advanced tab to do so.

The import overwrites any original data and adds new data. In this example, no lookup fields settings
are configured, no records or characters are ignored, and no records are specifically selected based
on text strings.

Note:
The steps that follow are intended only as an example - any characteristic can be used to create any
dimension in Profitability and Cost Management. For more information, see How to use DataBridge to
bring SAP BW Query data to SAP Business Objects PCM 7.5, available on the SAP Developer Network
(SDN) at https://www.sdn.sap.com.
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1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:
• Select Create a new Data Bridge control file and specification file using the Wizard in the

"Welcome" dialog box.
• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse button ( ) to the right of the Specification File

box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The screen displays the Link ID box.

7. In the Link ID box do one the following:
• Select the link that you set up to connect to the SAP Netweaver BW query cube
• Create a new link to the SAP Netweaver BW query cube.

8. Click Next.
The screen displays the options Import Structure and Import Values. Import Structure is selected
by default.

9. Click Next.
10. In the "Import OLAP Structure" screen, select Catalog Your cube > Cubes > Your cube/Your query

> Dimensions > 0COSTCENTER > Hierarchies > Your hierarchy. Select the topmost node and click
Next.
Selecting a hierarchy selects all its children.

11. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

12. In the "Table Setup" screen, select PARENTCHILD in the Table list. Click Next.
The Overwrite and append option is selected by default.

13. In the "Field Mappings" screen, set mappings as follows:
a. For the "DimensionName" field, select Responsibility Centers in the Mapping list.
b. For the "ParentName" field, select Field3: PARENT_NAME in the Mapping list.
c. For the "ChildName" field, select Field1: MEMBER_NAME in the Mapping list.
d. For the "AtrributeFlag" field, select 10 (Main Hierarchy Only) in the Mapping list.

This is an optional field.
e. For the "ConsolidationType" field, select + (Add) in the Mapping list.

14. Click Preview to verify that you have mapped the fields correctly.
15. Click Next.
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16. In the "Lookup Fields" screen, click Next.
17. In the "Ignore Records" screen, click Next.
18. In the "Select Records" screen, click Next.
19. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

20. In the Run Options screen, click Next.
21. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Related Topics
• Workflow for importing structure from an OLAP cube
• Creating a link to an SAP Netweaver BW datasource

5.4.3.3 Example: To create a SPE file to import values from SAP Netweaver®
Business Warehouse

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import Line Item values that do not have a zero value from SAP Netweaver BW into a Profitability
and Cost Management model.

These steps assume the following:
• You have created a query cube in SAP Business Explorer (SAP BEx)
• Your query has 0COSTCENTER, 0VERSION, 0FISCYEAR, 0COSTELMNT, and 0CURRENCY in

either rows or free characteristics
• You have a key figure called “Line Item Values” in Columns.

Remember:
Ensure that you release the query for External Access. Go to BEx Query Properties and open the
Advanced tab to do so.

The import overwrites any original data and adds new data. In this example, no lookup fields settings
are configured, no records or characters are ignored, and no records are specifically selected based
on text strings.

Note:
The steps that follow are intended only as an example. For more information, see How to use DataBridge
to bring SAP BW Query data to SAP Business Objects PCM 7.5, available on the SAP Developer
Network (SDN) at https://www.sdn.sap.com.

1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:
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Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

•

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse button ( ) to the right of the Specification File

box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The screen displays the Link ID box.

7. In the Link ID box do one the following:
• Select the link that you set up to connect to the SAP Netweaver BW query cube
• Create a new link to the SAP Netweaver BW query cube.

8. Click Next.
The screen displays the options Import Structure and Import Values. Import Structure is selected
by default.

9. Select Import Values.
The Run MDX Generation Wizard check box appears and is selected by default.

10. Click Next.
11. In the first "MDX Wizard" screen, select the relevant catalog in the list and select the query cube

that you want to import from in the Select a cube list.
12. In the Select a measure list select LineItemValue.
13. Select Filter Value and enter <>0 in the box to filter out zero values.
14. Click Next
15. In the second "MDX Wizard" screen, choose a selection option, for example Select all Descendent

items, to select which hierarchy items to import.
16. For each characteristic in the query - 0COSTCENTER, 0VERSION, 0FISCYEAR, 0COSTELMNT,

and 0CURRENCY - expand the hierarchy in the navigation tree and select the appropriate hierarchy
level. Then click Next.
The" Preview SQL or MDX Statement" screen displays the generated MDX statement. The Grid tab
displays the first 50 records from the query.

17. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

18. In the "Table Setup" screen, select LINEITEMVALUE in the Table list. Click Next.
The Overwrite and append option is selected by default.

19. In the "Field Mappings" screen, ensure the mappings are set as follows:

2010-01-2686

Using Data Bridge



a. For the "VersionName" field, select FieldX: 0VERSION in the Mapping list.
b. For the "PeriodName" field, select FieldX: 0FISCYEAR in the Mapping list.
c. For the "RespCenterName" field, select FieldX: 0COSTCENTER in the Mapping list.
d. For the "LineItemName" field, select FieldX: 0COSTELMNT in the Mapping list.
e. For the "CurrencyName" field, select FieldX: 0CURRENCY in the Mapping list.
f. For the "LineItemValue" field, select FieldX: Line Item Values in the Mapping list.

20. Click Next.
21. In the "Lookup Fields" screen, click Next.
22. In the "Ignore Records" screen, click Next.
23. In the "Select Records" screen, click Next.
24. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

25. In the Run Options screen, click Next.
26. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Related Topics
• Workflow for importing values from an OLAP cube
• Creating a link to an SAP Netweaver BW datasource

5.4.3.4 Example: To create a SPE file to import an Microsoft Access database
table

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import a Microsoft Access database table that contains the structure of a Profitability and Cost
Management model in a table named PARENTCHILD into another Profitability and Cost Management
model. In this example, no lookup fields settings are configured, no records or characters are ignored,
and no records are specifically selected based on text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse ( ) to the right of the Specification File box.
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4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want
to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The screen displays the Link ID box.

7. In the Link ID box, do one of the followiing:
• Select the link that you set up to connect to the Microsoft Access database.
• Create a new link to the Microsoft Access database .

8. Click Next.
9. In the "Relational Database Options" screen, select PARENTCHILD from the Select a table or view

to import data from list.
The Select which fields to import box lists all the fields in the table.

10. Click Next.
The" Preview SQL or MDX Statement" screen displays the generated SQL statement as follows:
SELECT * FROM PARENT_CHILD. The Grid tab displays the first 50 records from the query.

11. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

12. In the "Table Setup" screen, select PARENTCHILD in the Table list. Click "Next".
The Overwrite and append option is selected by default.

13. In the "Field Mappings" screen, set mappings as follows:
a. For the "DimensionName" field, select Activities in the Mapping list.
b. For the "ParentName" field, select PARENTNAME in the Mapping list.
c. For the "ChildName" field, select CHILDNAME in the Mapping list.
d. For the "AtrributeFlag" field, select ATTRIBUTEFLAG in the Mapping list.

This is an optional field.
e. For the "ConsolidationType" field, select CONSOLIDATIONTYPE in the Mapping list.

14. Click Next.
15. In the "Lookup Fields" screen, click Next.
16. In the "Ignore Records" screen, click Next.
17. In the "Select Records" screen, click Next.
18. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

19. In the Run Options screen, click Next.
20. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.
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Example:

The generated SPE file is as follows:

//Table Destination
TABLE PARENTCHILD
//Fields to be loaded from source file
ACROSS ParentName, ChildName, AttributeFlag, ConsolidationType
//Set delimiter.
TREAT ',' Delimiter
//Data is delimited.
//Set fixed values.
REPEAT DimensionName EVERY 1 LINE USING Activities
RECORD Control
DATA(A*)
DATA(A*)
DATA(A*)
DATA(N*)
DATA(A*)

SKIP TO EOL
END ON EOF

Related Topics
• Example: To create a link to a Microsoft Access database

5.4.3.5 Example: To create a SPE file to import a Microsoft Excel spreadsheet

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import a Microsoft Excel spreadsheet of LineItemValues exported from one Profitability and Cost
Management model into another Profitability and Cost Management model. The import overwrites any
original data and adds new data. In this example, no lookup fields settings are configured, no records
or characters are ignored, and no records are specifically selected based on text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse ( ) to the right of the Specification File box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.
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The screen displays the Link ID box.

7. In the Link ID box, do one of the followiing:
• Select the link that you set up to connect to the Microsoft Excel workbook.
• Create a new link to the Microsoft Excel workbook.

8. Click Next.
9. In the "Relational Database Options" screen, select the worksheet that contains the LineItemValues

from the Select a table or view to import data from list.
The Select a table or view to import data from list displays all the worksheets in the workbook with
a dollar sign ($) appended to their names.
The Select which fields to import box lists all the fields in the table.

10. Click Next.
The" Preview SQL or MDX Statement" screen displays the generated SQL statement as follows:
SELECT * FROM ['<worksheet name>']. The Grid tab displays the first 50 records from the query.

Note:
The Excel ODBC link uses the top row of data in a worksheet as the field names.

11. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

12. In the "Table Setup" screen, select LINEITEMVALUE in the Table list. Click Next.
The Overwrite and append option is selected by default.

13. In the "Field Mappings" screen, set mappings as follows:
a. For the "VersionName" field, select in the Mapping list the field name in the worksheet that

contains Version names.
b. For the "PeriodName" field, select in the Mapping list the field name in the worksheet that contains

Period names.
c. For the "RespCenterName" field, select in the Mapping list the field name in the worksheet that

contains Responsibility Centers names.
d. For the "LineItemName" field, select in the Mapping list the field name in the worksheet that

contains Line Items names.
e. For the "CurrencyName" field, select in the Mapping list the field name in the worksheet that

contains Currency names.
f. For the "LineItemValue" field, select in the Mapping list the field name in the worksheet that

contains LineItemValue values.

14. Click Preview to verify that you have mapped the fields correctly.
15. Click Next.
16. In the "Lookup Fields" screen, click Next.
17. In the "Ignore Records" screen, click Next.
18. In the "Select Records" screen, click Next.
19. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

20. In the Run Options screen, click Next.
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21. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Example:

The following is an example of the generated SPE file:

//Table Destination
TABLE LINEITEMVALUE
//Fields to be loaded from source file
ACROSS VersionName, PeriodName, RespCenterName, LineItemName, CurrencyName, LineItemValue
//Set delimiter.
TREAT ',' Delimiter
//Data is delimited.
RECORD Control
DATA(A*)
DATA(A*)
DATA(A*)
DATA(A*)
DATA(A*)
DATA(N*)

SKIP TO EOL
END ON EOF

5.4.3.6 Example: To create a SPE file to import a Profitability and Cost
Management database table

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import a relational database table that contains structural data from one Profitability and Cost
Management model into another Profitability and Cost Management model. In this example, no lookup
fields settings are configured, no records or characters are ignored, and no records are specifically
selected based on text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse ( ) to the right of the Specification File box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
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6. In the "Select Datasource" screen, select Import from external datasource.
The screen displays the Link ID box.

7. In the Link ID box, do one of the following:
• Select the link that you set up to connect to the database.
• Create a new link to the database.

8. Click Next.
9. In the "Relational Database Options" screen, select the table that contains the structural data that

you want to import from the Select a table or view to import data from list.
The Select which fields to import box lists all the fields in the table.

10. Click Next.
The" Preview SQL or MDX Statement" screen displays the generated SQL statement as follows:
SELECT * FROM <Table name>. The Grid tab displays the first 50 records from the query.

11. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

12. In the "Table Setup" screen, select PARENTCHILD in the Table list. Click "Next".
The Overwrite and append option is selected by default.

13. In the "Field Mappings" screen, set mappings as follows:
a. For the field that contains the dimension name, select the appropriate value in the Mapping list.
b. For the field that contains the parent name field, select the appropriate value in the Mapping list.
c. For the field that contains the child name, select the appropriate value in the Mapping list.
d. Select an appropriate attribute flag value in the Mapping list or enter an appropriate constant.

This is an optional field.
e. For the field that contains the consolidation type, select an appropriate value that represents the

consolidation type in the Mapping list.

14. Click Next.
15. In the "Lookup Fields" screen, click Next.
16. In the "Ignore Records" screen, click Next.
17. In the "Select Records" screen, click Next.
18. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

19. In the Run Options screen, click Next.
20. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Related Topics
• Creating a link to a relational database
• Workflow for a relational database table
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5.4.3.7 Example: To create a SPE file to import OLAP structural data

This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import the structure of the Responsibility Centers dimension from one Profitability and Cost
Management model into another Profitability and Cost Management model. In this example, no lookup
fields settings are configured, no records or characters are ignored, and no records are specifically
selected based on text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse button ( ) to the right of the Specification File

box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The screen displays the Link ID box.

7. In the Link ID box, do one of the followiing:
• Select the link that you set up to connect to the Profitability and Cost Management model.
• Create a new link to the Profitability and Cost Management model.

8. Click Next.
9. In the "Import OLAP Structure" screen, expand the catalog that contains the model, expand Cubes,

and select the model from which you want to import. Expand Dimensions, select the dimension,
expand Responsibility Centers and select the hierarchy you want to import.
Selecting a hierarchy selects all its children.

10. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

11. In the "Table Setup" screen, select PARENTCHILD in the Table list. Click Next.
The Overwrite and append option is selected by default.

12. In the "Field Mappings" screen, set mappings as follows:
a. For the "DimensionName" field, select Responsibility Centers in the Mapping list.
b. For the "ParentName" field, select PARENT_NAME in the Mapping list.
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c. For the "ChildName" field, select MEMBER_NAME in the Mapping list.
d. For the "AtrributeFlag" field, select ATTRIBUTEFLAG in the Mapping list.

This is an optional field.
e. For the "ConsolidationType" field, select CONSOLIDATIONTYPE in the Mapping list.

13. Click Next.
14. In the "Lookup Fields" screen, click Next.
15. In the "Ignore Records" screen, click Next.
16. In the "Select Records" screen, click Next.
17. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

18. In the Run Options screen, click Next.
19. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Example:

The following is an example of the generated SPE file:

//Table Destination
TABLE PARENTCHILD
//Fields to be loaded from source file
ACROSS Parentage, ChildName, AttributeFlag, ConsolidationType
//Set fixed values
REPEAT DimensionName EVERY 1 LINE USING 'Responsibility Centers'
//Set delimiter.
TREAT ',' Delimiter
//Data is delimited.
RECORD Control
DATA(A*)
SKIP TO DELIMITER
DATA(A*)
SKIP TO DELIMITER
SKIP TO DELIMITER
SKIP TO DELIMITER
DATA(N*)
DATA(A*)

SKIP TO EOL
END ON EOF

Related Topics
• To create a link to an OLAP cube
• Workflow for importing structure from an OLAP cube

5.4.3.8 Example: To create a SPE file to import OLAP values data
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This task example uses the "Data Bridge Specification Wizard" to create a new Specification (SPE) file
to import LineItemValues greater than 0 from one Profitability and Cost Management model into another
Profitability and Cost Management model. The import overwrites existing data and adds new data. In
this example, no lookup fields settings are configured, no records or characters are ignored, and no
records are specifically selected based on text strings.
1. Open Data Bridge and launch the "Specification Wizard" by doing one of the following:

• Select Create a new Data Bridge control file and specification file using the Wizard in the
"Welcome" dialog box.

• Click the Create a new Specification file icon on the toolbar
• Select Edit > Insert
• Press the INSERT key on your keyboard

2. In the "Welcome" screen, click Next.
3. In the "Specification File" screen, click the Browse button ( ) to the right of the Specification File

box.
4. In the "Select a Data Bridge Specification File" dialog box, navigate to the location where you want

to save the SPE file, enter a name for the file in the File name box, and click OK.
The Specification File box displays the filepath for the new SPE file.

5. Click Next.
6. In the "Select Datasource" screen, select Import from external datasource.

The screen displays the Link ID box.

7. In the Link ID box, do one of the followiing:
• Select the link that you set up to connect to the Profitability and Cost Management model.
• Create a new link to the Profitability and Cost Management model.
The screen displays the options Import Structure and Import Values. Import Structure is selected
by default.

8. Select Import Values.
The Run MDX Generation Wizard check box appears and is selected by default.

9. Click Next.
10. In the first "MDX Wizard" screen, select the relevant catalog in the list and select the model that you

want to import from in the Select a cube list.
11. In the Select a measure list select LineItemValue.
12. Select Filter Value and enter >0 in the box to filter for values greater than 0.
13. Click Next
14. In the second "MDX Wizard" screen, choose a selection option, for example Select all Descendent

items.
15. Select Versions in the "Dimension" pane and in the navigation tree on the left, expand Versions >

Hierarchies > Versions and select the appropriate hierarchy item.
16. Repeat steps 12 and 13 for all key dimensions for the LineItemValue measure in the following order:

Periods, Responsibility Centers, Line Items, and Currencies. Then click Next.
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The" Preview SQL or MDX Statement" screen displays the generated MDX statement. The Grid tab
displays the first 50 records from the query.

17. In the Configure Specification File screen, ensure the Run the specification wizard check box is
selected and click Next.

18. In the "Table Setup" screen, select LINEITEMVALUE in the Table list. Click Next.
The Overwrite and append option is selected by default.

19. In the "Field Mappings" screen, ensure the mappings are set as follows:
a. For the "VersionName" field, select Field 1: Versions in the Mapping list.
b. For the "PeriodName" field, select Field 2: Periods in the Mapping list.
c. For the "RespCenterName" field, select Field 3: Responsibility Centers in the Mapping list.
d. For the "LineItemName" field, select Field 4: Line Items in the Mapping list.
e. For the "CurrencyName" field, select Field 5: Currencies in the Mapping list.
f. For the "LineItemValue" field, select Field 6: LineItemValue in the Mapping list.

20. Click Next.
21. In the "Lookup Fields" screen, click Next.
22. In the "Ignore Records" screen, click Next.
23. In the "Select Records" screen, click Next.
24. In the "Ignore Characters" screen, click Next.

The "Generated SPE File" screen displays a preview of the generated SPE file.

25. In the Run Options screen, click Next.
26. On the final page of the wizard, click Finish.

The display pane in Data Bridge lists the new SPE file. The file contents are visible in the View SPE file
tab at the bottom of the screen.

Example:

The following is an example of the generated SPE file:

//Table Destination
TABLE LINEITEMVALUE
//Fields to be loaded from source file
ACROSS VersionName, PeriodName, RespCenterName, LineItemName, CurrencyName, LineItemValue
//Set delimiter.
TREAT ',' Delimiter
//Data is delimited.
RECORD Control
DATA(A*)
DATA(A*)
DATA(A*)
DATA(A*)
DATA(A*)
DATA(N*)

SKIP TO EOL
END ON EOF

Related Topics
• Workflow for importing values from an OLAP cube
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• To create a link to an OLAP cube

5.5 Running the Control File

To execute the Control file:
1. Do one of the following:

• Click the Execute current control file icon on the toolbar.
• Select Run > Execute Control File from the menu bar.
• Press F8.
The "Run Data Bridge" dialog box shows the details of the current model.

This dialog shows the details of the current model.

2. In the "Model Options" area, click the Browse button to the right of the Model box to browse
for the model that the data will be run into.
The "Select Model" dialog box appears.

3. Select the model and click OK.
The new model name appears in the Model box.

The options available in the screen are:
• Allow Creation of Structure – This checkbox is selected by default. It allows new model structure to

be created that does not already exist in the model. If you wish to import data values only into an
existing structure, then you should deselect this option.

Note:
If Allow Creation of Structure is not selected, then any new data structure and associated values
will be ignored.

• Generate Trace – This option will run a trace on all Specification files where Trace On was selected
in the "Run Options" screen.

• Run – This will start Data Bridge and will run the import process. The status bar at the bottom will
give you a guide as to the percentage of the import that has been completed.

• Sort – This will perform a sort of the hierarchical structure within a model. Once a model has a
dimension hierarchy structure in place, it is possible to sort it into either Ascending order (A to Z or
0 to 9), or Descending order (Z to A, 9 to 0). Once the Sort button has been clicked, a "Sort Dimension
Structure" dialog box opens that allows you to specify which Dimensions to be sorted in the
Dimensions list, which Alias will be used to perform the Sort in the Data Alias list, and whether the
Sort is Descending or Ascending.

• View Trace – This will open the Trace report in Windows Notepad. By default, the report is saved
as a TRC file in your Windows temporary directory. This button only becomes active when the Generate
trace option has been selected.

• View Alerts
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When the import is completed a confirmation message appears. The message box informs you how
many lines of the imported file were read and how many were ignored, and asks whether you wish to
view the model alerts. If you click Yes, the "Alerts" dialog box displays. The dialog box lists alerts for
the records Data Bridge has ignored. You can also view a description of the ignored record.

You can also view alerts for ignored import records by clicking Security Alerts in the Model Builder task
bar and then clicking the Model Alerts tab in the "Alerts" dialog box.

Note:

• When Trace is switched on, the import will take longer to complete.
• Once a Sort has been performed, it is NOT possible to revert back to the original order.
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Running Control Files from a Command Line

The Data Bridge application offers you the opportunity to run Data Bridge control files from either the
command line or a batch file. SAP BusinessObjects Profitability and Cost Management users can use
PCMCONSOLE. Windows users of this application can run from either a command line or through the Console
Wizard.

6.1 To run from the command line using PCMCONSOLE

Note:
PCMCONSOLE can also be used with command files to arrange for several commands to be performed in
sequence.

1. Navigate to the directory that holds your SAP BusinessObjects Profitability and Cost Management
programs.
On a Windows system, it is: C:\ Program Files\Common Files\SAP BusinessObjects\PCM.

2. Type PCMCONSOLE, followed by the following parameters:
• USERNAME=<user>
• PASSWORD=<password>
• OPEN =<modelname>
• DATABRIDGEIMPORT=<Data Bridge control file>
• any additional PCMCONSOLE parameters you need (see the SAP BusinessObjetcts Profitability and

Cost Management Console User Guide)

PCMCONSOLE username=user password=pass open=Profitabilitymodel databridgeimport=c:\ADBImport
spec.ctf prefixdate log=c:\MyLog.txt
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SAP BusinessObjects Profitability and Cost Management
Tables

This section contains a list of all the fields in input tables in the application.

Related Topics
• Alias Table Fields
• Attribute Flags
• Consolidation Types
• Data Aliases
• The ParentChild Table

7.1 ACTIVITYDRIVERVALUE

Description: Records the values associated
with a specific Activity Driver.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Activity Driver ”KeyActivityDriverName

The name of a “Cost Object ”KeyCostObject1Name

The name of a “Cost Object ”KeyCostObject2Name

The name of a “Cost Object ”KeyCostObject3Name

The name of a “Cost Object ”KeyCostObject4Name

The name of a “Cost Object ”KeyCostObject5Name

ActivityDriverValueNumericActivityDriverValue
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Description: Records the values associated
with a specific Activity Driver.Field AttributeField Name

ActivityDriverDeltaValueNumericActivityDriverDeltaValue

ActivityDriverTargetValueNumericActivityDriverTargetValue

7.2 ACTIVITYREASSIGN

Description: Records all the details of an
Activity reassignment.Field AttributeField Name

Defaults use the root name of the dimen-
sion, that is “Versions”KeyVersionName

Defaults use the root name of the dimen-
sion, that is “Periods”KeyPeriodName

Defaults use the root name of the dimen-
sion, that is “Responsibility Centers ”KeyRespCenterName

The name of an “Activity”KeyActivityName

The“ Resource Driver ”KeyResourceDriverName

The Allocation DriverKeyActivityResourceDriverName

The target <All Responsibility Centers> is
specified as “Responsibility Centers”KeyTargetRespCenterName

The target <All Performed Activities> is
specified as “Activities”KeyTargetActivityName

7.3 ALIAS, ALIAS_BULK

Description: Records alias names for items
in all dimensionsField AttributeField Name

KeyDimensionName
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Description: Records alias names for items
in all dimensionsField AttributeField Name

The Data Alias group name , for example
Default AliasKeyDataAliasName

Leave blank - these should be defined
through the Attribute Flags field of the Par

entChild table.
OptionalAttribute Flag

The Alias name of the item under the
DataAliasName specified above.KeyAlias

The Default Alias name of the item.OptionalDefaultAlias

Monitoring information – leave input data
blankOptionalAttributeInfo

7.4 BOUNDARYINFO

Description: Records Boundary
Group detailsField AttributeField Name

A boundary groupKeyBoundaryGroupName

A boundary nameKeyBoundaryName

An icon nameKeyIconName

A colorOptionalRangeColor

A colorOptionalDataColor

7.5 COSTOBJECTDRIVER
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Description: Identifies the drivers in a Cost
Object Assignment. Also records where
their values are located and the order in
which they are to be applied.

Field AttributeField Name

Default is “Responsibility Centers”KeyRespCenterName

“Line Item”, “Activity”, or “Service” NameKeyLineItemActivityName

“Activities”, “Line Items”, or “Services”KeyLineItemActivityTypeName

“Activity Driver” for “Cost Object 1”AlphaActivityDriver1Name

“Activity Driver ”for “Cost Object 2”AlphaActivityDriver2Name

“Activity Driver” for “Cost Object 3 ”AlphaActivityDriver3Name

“Activity Driver” for “Cost Object 4”AlphaActivityDriver4Name

“Activity Driver” for “Cost Object 5 ”AlphaActivityDriver5Name

Location of “Activity Drivers” Values for
“Cost Object 1” (0 - All, 1 - Parent, 2 -
Current, 3007 - RC Unassigned)

OptionalVolumeRespCenter1Type

Location of “Activity Drivers” Values for
Cost Object 2 (0 - All, 1 - Parent, 2 - Cur-
rent, 3007 - RC Unassigned)

OptionalVolumeRespCenter2Type

Location of “Activity Drivers” Values for
“Cost Object 3” (0 - All, 1 - Parent, 2 -
Current, 3007 - RC Unassigned)

OptionalVolumeRespCenter3Type

Location of “Activity Drivers” Values for
“Cost Object 4” (0 - All, 1 - Parent, 2 -
Current, 3007 - RC Unassigned)

OptionalVolumeRespCenter4Type

Location of “Activity Drivers” Values for
“Cost Object 5” (0 - All, 1 - Parent, 2 -
Current, 3007 - RC Unassigned)

OptionalVolumeRespCenter5Type

Numeric order that “Cost Object” 1-5
drivers are applied (First is 1, Second is 2,
and so on)

OptionalOrder1

Numeric order that “Cost Object” 1-5
drivers are applied (First is 1, Second is 2,
and so on c)

OptionalOrder2

Numeric order that “Cost Object” 1-5
drivers are applied (First is 1, Second is 2,
and so on )

OptionalOrder3
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Description: Identifies the drivers in a Cost
Object Assignment. Also records where
their values are located and the order in
which they are to be applied.

Field AttributeField Name

Numeric order that “Cost Object” 1-5
drivers are applied (First is 1, Second is 2,
and so on )

OptionalOrder4

Numeric order that “Cost Object” 1-5
drivers are applied (First is 1, Second is 2,
and so on )

OptionalOrder5

7.6 CELLMEMOS

Description: Records a memo
string against a specific grid
item

Field AttributeField Name

The memo stringKeyCellMemo

Identifies the type of Grid Value
that the memo refers toNumericTableFieldID

An item name in the first key di-
mensionKeyDimension1ItemName

The EPOCode of the itemKeyDimension1ItemEPOCode

An item name in the second key
dimensionKeyDimension2ItemName

The EPOCode of the itemKeyDimension2ItemEPOCode

An item name in the third key
dimensionKeyDimension3ItemName

The EPOCode of the itemKeyDimension3ItemEPOCode

An item name in the fourth key
dimensionKeyDimension4ItemName

The EPOCode of the itemKeyDimension4ItemEPOCode

An item name in the fifth key di-
mensionKeyDimension5ItemName
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Description: Records a memo
string against a specific grid
item

Field AttributeField Name

The EPOCode of the itemKeyDimension5ItemEPOCode

An item name in the sixth key
dimensionKeyDimension6ItemName

The EPOCode of the itemKeyDimension6ItemEPOCode

An item name in the seventh key
dimensionKeyDimension7ItemName

The EPOCode of the itemKeyDimension7ItemEPOCode

An item name in the eighth key
dimensionKeyDimension8ItemName

The EPOCode of the itemKeyDimension8ItemEPOCode

An item name in the ninth key
dimensionKeyDimension9ItemName

The EPOCode of the itemKeyDimension9ItemEPOCode

An item name in the tenth key
dimensionKeyDimension10ItemName

The EPOCode of the itemKeyDimension10ItemEPOCode

An item name in the eleventh
key dimensionKeyDimension11ItemName

The EPOCode of the itemKeyDimension11ItemEPOCode

An item name in the twelfth key
dimensionKeyDimension12ItemName

The EPOCode of the itemKeyDimension12ItemEPOCode

An item name in the thirteenth
key dimensionKeyDimension13ItemName

The EPOCode of the itemKeyDimension13ItemEPOCode

An item name in the fourteenth
key dimensionKeyDimension14ItemName

The EPOCode of the itemKeyDimension14ItemEPOCode

An item name in the fifteenth key
dimensionKeyDimension15ItemName
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Description: Records a memo
string against a specific grid
item

Field AttributeField Name

The EPOCode of the itemKeyDimension15ItemEPOCode

7.7 COSTOBJECTASSIGNMENT

Description: Records the source and target
items involved in a Cost Object Assign-
ment.

Field AttributeField Name

Default is “Responsibility Center”KeyRespCenterName

“Line Item”, “Activity”, or “Service” NameKeyLineItemActivityName

“Activities”, “Line Items”, or “Services”KeyLineItemActivityTypeName

The item name of a “Cost Object” in one
of the target “Cost Object” dimensionsKeyCostObjectName

The target “Cost Object” dimension the
item belongs to in the form “Cost Objects
x” where x is in the range 1-5.

KeyCostObjectTypeName

7.8 CURRENCYINFO

Description: Records Currency formatting
detailsField AttributeField Name

CurrencyNameAlphaCurrencyName

CurrencySymbolAlphaCurrencySymbol

CurrencyDecimalAlphaCurrencyDecimal

CurrencyThousandAlphaCurrencyThousand

CurrencyGroupingAlphaCurrencyGrouping
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Description: Records Currency formatting
detailsField AttributeField Name

CurrencyPosCurrencyAlphaCurrencyPosCurrency

CurrencyNegCurrencyAlphaCurrencyNegCurrency

CurrencyDigitsAlphanumCurrencyDigits

CurrencyDescriptionAlphaCurrencyDescription

7.9 CURRENCYRATE

Description: Records Currency Rates by Version
and Period.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Currency”KeyCurrencyName

CurrencyRateNumericCurrencyRate

7.10 DAVERSION

Description: Records details about Driver Analysis
versions.Field AttributeField Name

The name of the Driver Analysis “Version”KeyVersionName

The name of the Source “Version” the Driver
Analysis “Version” is based on.KeyReferenceVersionName
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7.11 DEFAULTBOOK

Description: Records the Default
book associated with a User groupField AttributeField Name

The name of a bookAlphanumBookName

The name of a User GroupAlphanumGroupName

7.12 EMPLOYEEBOUNDARY

DescriptionField AttributeField Name

The name of an “Employee”KeyEmployeeName

The name of a “Boundary” groupKeyBoundaryGroupName

The name of a measureKeyMeasureName

7.13 EMPLOYEEBOUNDARYVALUE

DescriptionField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility
Center”KeyRespCenterName

The name of an “Employee”KeyEmployeeName

The name of a “Boundary”KeyBoundaryName

The name of a “Cost Object”KeyCostObject1Name
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DescriptionField AttributeField Name

The name of a “Cost Object”KeyCostObject2Name

The percentage of a “Boundary”
value for an “Employee”NumericEmployeePercentBoundaryValue

7.14 EMPLOYEERESOURCEDRIVERSPLIT

DescriptionField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility
Center”KeyRespCenterName

The name of an “Employee”KeyEmployeeName

The name of a “Resource Driver”KeyResourceDriverName

The name of an “Activity”KeyActivityName

The split resource value of an
“Employee”NumericEmployeeResourceDriverSplit

7.15 LINEITEMDETAILVALUE

Description: Records Line Item Detail valuesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item Detail”KeyLineItemDetailName

The name of a “Line Item”KeyLineItemName
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Description: Records Line Item Detail valuesField AttributeField Name

The currency applied to be applied to the
“LineItemDetailValue”KeyCurrencyName

The value of a “Line Item Detail”NumericLineItemDetailValue

7.16 INITIATIVEINFO

Description: Records Initiative
detailsField AttributeField Name

An Initiative nameKeyInitiativeName

Initiative categoryAlphaProperty

Initiative valueAlphaValue

7.17 EXTACTCOUNITRATE

Description: Contains external
“Activity Cost Object” unit rates for
a Transactional Costing model type

Field AttributeField Name

The name of the “Version”AlphaVersionName

The name of the “Period”AlphaPeriodName

The name of the “Responsibility
Center”KeyRespCenterName

The name of the “Activity”KeyActivityName

The name of the “Activity Driver”KeyActivityDriverName

The name of the “Cost Objects 1”
dimension itemAlphaCostObject1Name

The name of the “Cost Objects 2”
dimension itemAlphaCostObject2Name
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Description: Contains external
“Activity Cost Object” unit rates for
a Transactional Costing model type

Field AttributeField Name

The name of the “Cost Objects 3”
dimension itemAlphaCostObject3Name

The name of the “Cost Objects 4”
dimension itemAlphaCostObject4Name

The name of the “Cost Objects 5”
dimension itemAlphaCostObject5Name

The unit rate of an external “Activity
Cost Object”OptionalExtActivityCostObjectUnitRate

The Fixed unit rate of an external
“Activity Cost Object”OptionalExtActivityCostObjectFixedUni

tRate

7.18 EXTERNALACTIVITYVALUE

Description: Records the externally speci-
fied value of an ActivityField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item”KeyLineItemName

The name of an “Activity”KeyActivityName

The name of a “Currency”KeyCurrencyName

ValueNumericExternalActivityValue

Fixed valueNumericExternalActivityFixedValue
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7.19 EXTERNALCOSTOBJECTVALUE

Description: Records the externally speci-
fied value of Cost Object combinationField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item”KeyLineItemName

The name of an “Activity”KeyActivityName

The name of a “Cost Object”KeyCostObject1Name

The name of a “Cost Object”KeyCostObject2Name

The name of a “Cost Object”KeyCostObject3Name

The name of a “Cost Object”KeyCostObject4Name

The name of a “Cost Object”KeyCostObject5Name

The name of a “Currency”KeyCurrencyName

ValueNumericExternalCostObjectValue

Fixed valueNumericExternalCostObjectFixedValue

7.20 ICONINFO

Description: Records Icon detailsField AttributeField Name

An Icon nameKeyIconName

Icon categoryAlphaProperty

Icon valueAlphaValue
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7.21 LINEITEMDIRECTACTIVITY

Description: Records Line Items that are as-
signed directly to an Activity.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period ”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item”KeyLineItemName

The name of an “Activity”KeyActivityName

7.22 LINEITEMFVALUE

Description: Records Line Item fixed values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item”KeyLineItemName

The currency applied to the LineItemFixedVal

ue
KeyCurrencyName

The Fixed value of a “Line Item”NumericLineItemFixedValue

7.23 LINEITEMRESOURCEDRIVER
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Description: Records Line Items
/ Resource Driver assignmentsField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Line Item”KeyLineItemName

The name of a “Responsibility
Center”KeyRespCenterName

KeyResourceDriverName

7.24 LINEITEMVALUE

Description: Records Line Item values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Line Item”KeyLineItemName

The name of a “Currency”KeyCurrencyName

The value of a “Line Item”NumericLineItemValue

The Delta value of a “Line Item”NumericLineItemDeltaValue

7.25 LINEITEMVARIABLE

Description: Records Line Item values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName
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Description: Records Line Item values.Field AttributeField Name

The name of a “Responsibility Center”KeyRespCenterName

The value of a “Line Item”KeyLineItemName

The Variability value of the “Line Item”NumericLineItemVariability

7.26 MEMOS

Description: Records memo strings against
dimension items.Field AttributeField Name

A dimension nameKeyDimensionName

The name of an item in the dimensionKeyDimensionItemName

For example, Default AliasKeyDataAliasName

A memo stringAlphanumMemo

7.27 METRICACTUALADJUSTMENTVALUE

Description: Records Metric Actual Adjust-
ment values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Currency”KeyCurrencyName

A valueNumericMetricActualAdjustmentValue
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7.28 METRICACTUALVALUE

Description: Records Metric Actual val-
ues.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Currency”KeyCurrencyName

A valueNumericMetricActualValue

7.29 METRICBASEPOINTVALUE

Description: Records Metric Basepoint
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Currency”KeyCurrencyName

A valueNumericMetricBasepointValue

7.30 METRICBOUNDARY
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Description: Records Metric boundaries
measures.Field AttributeField Name

The name of a “Metric”KeyMetricName

The name of a “Boundary” GroupKeyBoundaryGroupName

The TableFieldID of a MeasureKeyMeasureName

7.31 METRICBOUNDARYVALUE

Description: Records Metric Boundary
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Boundary”KeyBoundaryName

A valueNumericMetricActualBoundaryValue

A valueNumericMetricPercentBoundaryValue

7.32 METRICRESPCENTER

Description: Records associations between
Metrics and Responsibility CentersField AttributeField Name

The name of a “Metric”KeyMetricName

The name of a “Responsibility Center”KeyRespCenterName
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7.33 METRICTARGETADJUSTMENTVALUE

Description: Records Metric Target Adjust-
ment values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Currency”KeyCurrencyName

A valueNumericMetricTargetAdjustmentValue

7.34 METRICTARGETVALUE

Description: Records Metric Target val-
ues.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Metric”KeyMetricName

The name of a “Currency”KeyCurrencyName

A valueNumericMetricTargetValue

7.35 METRICWEIGHTINGVALUE
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Description: Records Objective Metric
Weighting values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Objective”KeyObjectiveName

The name of a “Metric”KeyMetricName

A valueNumericObjectiveMetricWeightingValue

7.36 MODELGROUPS

Description: Records Model Group namesField AttributeField Name

The name of a “Model” GroupKeyGroupName

7.37 MODELSECURITYDESCRIPTORS

Description: Records Dimension item Se-
curity DescriptorsField AttributeField Name

KeyDimensionName

KeyDimensionItemName

The security descriptor associated with the
specified dimension item (for example,
Default Dimension Security)

KeySecurityDescriptorName
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7.38 OBJECTIVEACTUALVALUE

Description: Records Objective Actual
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective ”KeyObjectiveName

A valueNumericObjectiveActualValue

7.39 OBJECTIVEACTUALADJUSTVALUE

Description: Records Objective Actual Adjust-
ment values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

A valueNumericObjectiveActualAdjustmentValue

7.40 OBJECTIVEBASEPOINTVALUE
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Description: Records Objective Basepoint
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

A valueNumericObjectiveBasePointValue

7.41 OBJECTIVEBOUNDARY

Description: Records Objective boundaries
measures.Field AttributeField Name

The name of an “Objective”KeyObjectiveName

The name of a “Boundary” GroupKeyBoundaryGroupName

The TableFieldID of a MeasureKeyMeasureName

7.42 OBJECTIVEBOUNDARYVALUE

Description: Records Objective
Boundary valuesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

The name of a BoundaryKeyBoundaryName

A valueNumericObjectiveActualBoundaryValue

2010-01-26122

SAP BusinessObjects Profitability and Cost Management Tables



Description: Records Objective
Boundary valuesField AttributeField Name

A valueNumericObjectivePercentBoundaryValue

7.43 OBJECTIVEEMPLOYEE

Description: Records associations between
Objectives and EmployeesField AttributeField Name

The name of an “Objective ”KeyObjectiveName

The name of an “Employee”KeyEmployeeName

7.44 OBJECTIVEINITIATIVE

Description: Records associations between
Objectives and InitiativesField AttributeField Name

The name of an “Objective”KeyObjectiveName

The name of an “Initiative”KeyInitiativeName

7.45 OBJECTIVELOBJECTIVE

Description: Records associations be-
tween Objectives and Linked ObjectivesField AttributeField Name

The name of an “Objective”KeyObjectiveName

The name of an “Linked Objective”KeyLinkedObjectiveName
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7.46 OBJECTIVEMETRIC

Description: Records associations between
Objectives and MetricsField AttributeField Name

The name of an “Objective”KeyObjectiveName

The name of a “Metric”KeyMetricName

7.47 OBJECTIVERESPCENTER

Description: Records associations between
Objective and Responsibility CentersField AttributeField Name

The name of an “Objective”KeyObjectiveName

The name of “Responsibility Center”KeyRespCenterName

7.48 OBJECTIVETARGETADJUSTVALUE

Description: Records Objective Target
Adjustment values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

A valueNumericObjectiveTargetAdjustmentValue
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7.49 OBJECTIVETARGETVALUE

Description: Records Objective Target
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

A valueNumericObjectiveTargetValue

7.50 OBJECTIVEWEIGHTINGVALUE

Description: Records Objective Weighting
values.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Objective”KeyObjectiveName

The name of a “Linked Objective”KeyLinkedObjectiveName

A valueNumericObjectiveWeightingValue

7.51 PARENTCHILD, PARENTCHILD_BULK, PARENTCHILD_BULK_REPLACE
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Description: Records the hierarchy loca-
tion and consolidation type of items in
all dimensions.

Field AttributeField Name

Name of a dimensionKeyDimensionName

Name of a dimension itemKeyParentName

Name of a dimension itemKeyChildName

NumericData AliasesConsolidation

TypesAttribute Flags

AlphaConsolidation Types

7.52 PROPERTY

Description: Records the default values of
Property itemsField AttributeField Name

Name of a Property itemKeyPropertyName

Default ValueAlphanumDefaultValue

7.53 PROPERTYITEM

Description: Records the values of specific
Property itemsField AttributeField Name

Name of a property itemKeyPropertyName

Name of a dimensionKeyDimensionName

Name of a dimension itemKeyItemName

ValueAlphanumPropertyValue
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7.54 RESOURCEDRIVERVALUE

Description: Records Resource Driver
valuesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Resource Driver”KeyResourceDriverName

A valueNumericResourceDriverValue

A valueNumericResourceDriverDeltaValue

A valueNumericResourceDriverTargetValue

7.55 RESOURCEDRIVERSPLIT

Description: Records Resource Driver
Split valuesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center ”KeyRespCenterName

The name of a “Resource Driver”KeyResourceDriverName

The name of an “Activity”KeyActivityName

A valueNumericResourceDriverSplit

A valueNumericResourceDriverPctSplit

A valueNumericResourceDriverDeltaSplit

A valueNumericResourceDriverTargetSplit
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7.56 RESPCENTERACTIVITY

Description: Records the activities performed
in each Responsibility Center.Field AttributeField Name

The name of a “Responsibility Center”KeyRespCenterName

The name of an “Activity”KeyActivityName

7.57 RESPCENTERSERVICE

Description: Records the services provided
by each Responsibility Center.Field AttributeField Name

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Service ”KeyServiceName

7.58 REVENUE

Description: Records the revenue val-
ues of each Revenue Type for each Cost
Object

Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Revenue Type”KeyRevenueTypeName

The name of a “Cost Object”KeyCostObject1Name

The name of a “Cost Object”KeyCostObject2Name
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Description: Records the revenue val-
ues of each Revenue Type for each Cost
Object

Field AttributeField Name

The name of a “Cost Object”KeyCostObject3Name

The name of a “Cost Object”KeyCostObject4Name

The name of a “Cost Object”KeyCostObject5Name

The name of a “Currency”KeyCurrencyName

You must understand the relationship
between UnitPrice, UnitsSold, and
Revenue when attempting to input these
values (see your User Help)

NumericUnitPrice

A valueNumericUnitsSold

A valueNumericRevenue

7.59 SECURITYDESCRIPTORS

Description: Records Security DescriptorsField AttributeField Name

The name of a Security DescriptorKeySecurityDescriptorName

The name of a type of Security DescriptorKeySecurityDescriptorType

7.60 SECURITYDESCRIPTORGROUPS

Description: Records the level of access
that each User Group has through each Se-
curity Descriptor.

Field AttributeField Name

The name of a Security DescriptorKeySecurityDescriptorName

The name of a GroupKeyGroupName
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Description: Records the level of access
that each User Group has through each Se-
curity Descriptor.

Field AttributeField Name

1 - View Only; 3 - Edit Data; 7 - Edit Struc-
ture; 15 - Full Access. The No Access option
is given when no record exists.

OptionalAccess

7.61 SECURITYGROUPROOTS

Description: Records the top level item in a
dimension for each Security Descriptor.Field AttributeField Name

The name of a GroupKeyGroupName

The name of a DimensionKeyDimensionName

The name of a dimension itemKeyTopLevelName

7.62 SERVICEDIRECTACTIVITY

Description: Records Service Driver
Activity namesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Service”KeyServiceName

The name of an “Activity”AlphanumDirectActivityName
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7.63 SERVICEDRIVERVALUE

Description: Records Service Driver
valuesField AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Service”KeyServiceName

A valueNumericServiceDriverValue

7.64 SERVICEFACTOR

Description: Records the Unit Rates and
Variable Factors of a Service.Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility Center”KeyRespCenterName

The name of a “Service”KeyServiceName

The name of a “Currency”KeyCurrencyName

If this is non zero the service is Variable
RateNumericServiceVariableFactor

A valueNumericServiceFixedUnitRate

A valueNumericServiceUnitRate
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7.65 SERVICERESOURCEDRIVER

Description: Records Service /
Resource Driver assignments.Field AttributeField Name

The name of a “Service”KeyServiceName

The name of a “Responsibility
Center”KeyRespCenterName

The name of a “Resource Driv-
er”KeyResourceDriverName

7.66 SPREADVALUE

Description: Records the value
in a spread held against a specif-
ic version and period.

Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Spread”KeySpreadName

A valueNumericSpreadValue

7.67 TCACTIVITYDRIVERVOLUME

Description: Contains detailed volume
costs for a Transactional Costing model
type.

Field AttributeField Name

The name of the “Version”AlphaVersionName
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Description: Contains detailed volume
costs for a Transactional Costing model
type.

Field AttributeField Name

The name of the “Period”AlphaPeriodName

The name of the “Activity Driver”KeyActivityDriverName

The name of the “Detailed Cost Objects 1”
dimension itemKeyDetailedCostObject1Name

The name of the “Detailed Cost Objects 2”
dimension itemKeyDetailedCostObject2Name

The name of the “Detailed Cost Objects 3”
dimension itemKeyDetailedCostObject3Name

The name of the “Detailed Cost Objects 4”
dimension itemKeyDetailedCostObject4Name

The name of the “Detailed Cost Objects 5”
dimension itemKeyDetailedCostObject5Name

The Load ID of the “Activity Driver” data
loadOptionalTCActivityDriverLoadID

The source “Activity Driver” volume data
for “Detailed Cost Objects”OptionalTCActivityDriverVolume

7.68 USERGROUPS

Description: Records the group
a user belongs to.Field AttributeField Name

The name of a userKeyUserName

The name of a user groupKeyGroupName

7.69 USERSINFO
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Description: Records user infor-
mationField AttributeField Name

The name of a userKeyUserName

User email addressKeyEmailAddress

The full name of a userKeyUserFullName

Description of a userKeyUserDescription

KeySyntaxHighlighting

KeySID

7.70 WORKSHEETVALUE

Description: Records the Work-
sheet value in a specific cell of
a Worksheet matrix.

Field AttributeField Name

The name of a “Version”KeyVersionName

The name of a “Period”KeyPeriodName

The name of a “Responsibility
Center”KeyRespCenterName

The name of a “WorkSheet1”
itemKeyWorkSheet1Name

The name of a “WorkSheet2”
itemKeyWorkSheet2Name

A valueNumericWorkSheetValue
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Dimensions

The following table lists the dimensions provided in SAP BusinessObjects Profitability and Cost
Management, broken down by dimension group and model type.

Table 8-1: Dimensions by group and model type

Transactional CostingObjectives and MetricsProfitability and CostingDimension
Group

VersionsVersionsVersions

Core:
PeriodsPeriodsPeriods

Responsibility CentersResponsibility CentersResponsibility Centers

CurrenciesCurrenciesCurrencies

Line ItemLine Items
Line Item:

Line Item DetailsLine Item Details

ActivitiesActivities
Activity:

Resource DriversResource Drivers
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Transactional CostingObjectives and MetricsProfitability and CostingDimension
Group

Cost Objects 1Cost Object 1Cost Objects 1

Outputs:

Cost Objects 2Cost Object 2Cost Objects 2

Cost Objects 3Cost Objects 3

Cost Objects 4Cost Objects 4

Cost Objects 5Cost Objects 5

Revenue TypesRevenue Types

Activity DriversActivity Drivers

Detailed Cost Objects 1

Detailed Cost Objects 2

Detailed Cost Objects 3

Detailed Cost Objects 4

Detailed Cost Objects 5

ServicesIconsServices

General:

SpreadsBoundariesSpreads

Work Sheets 1ObjectivesWork Sheets 1

Work Sheets 1MetricsWork Sheets 2

EmployeesEmployeesEmployees

Capacity Rules
User Defined Rules

Capacity RulesSpecial
Rules: User Defined RulesUser Defined Rules
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More Information

LocationInformation Resource

http://www.sap.comSAP BusinessObjects product infor-
mation

Select http://help.sap.com > SAP BusinessObjects.

You can access the most up-to-date documentation covering all SAP
BusinessObjects products and their deployment at the SAP Help Portal.
You can download PDF versions or installable HTML libraries.

Certain guides are stored on the SAP Service Marketplace and are not
available from the SAP Help Portal. These guides are listed on the Help
Portal accompanied by a link to the SAP Service Marketplace. Customers
with a maintenance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support representative.

SAP Help Portal

http://service.sap.com/bosap-support > Documentation
• Installation guides: https://service.sap.com/bosap-instguides
• Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation guides, upgrade
and migration guides, deployment guides, release notes and Supported
Platforms documents. Customers with a maintenance agreement have
an authorized user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the SAP Service
Marketplace from the SAP Help Portal, use the menu in the navigation
pane on the left to locate the category containing the documentation you
want to access.

SAP Service Marketplace

https://boc.sdn.sap.com/

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
Developer resources

https://www.sdn.sap.com/irj/boc/businessobjects-articles

These articles were formerly known as technical papers.
SAP BusinessObjects articles on
the SAP Community Network
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LocationInformation Resource

https://service.sap.com/notes

These notes were formerly known as Knowledge Base articles.
Notes

https://www.sdn.sap.com/irj/scn/forumsForums on the SAP Community
Network

http://www.sap.com/services/education

From traditional classroom learning to targeted e-learning seminars, we
can offer a training package to suit your learning needs and preferred
learning style.

Training

http://service.sap.com/bosap-support

The SAP Support Portal contains information about Customer Support
programs and services. It also has links to a wide range of technical in-
formation and downloads. Customers with a maintenance agreement
have an authorized user ID to access this site. To obtain an ID, contact
your customer support representative.

Online customer support

http://www.sap.com/services/bysubject/businessobjectsconsulting

Consultants can accompany you from the initial analysis stage to the
delivery of your deployment project. Expertise is available in topics such
as relational and multidimensional databases, connectivity, database
design tools, and customized embedding technology.

Consulting
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